SIEMENS

SIMATIC HMI

Urz dzenie HMI
KTP400 Basic, KTP600 Basic,
KTP1000 Basic, TP1500 Basic

Instrukcja u ytkowa

01/2009
ABE02421799-01

Wst p

Przegl d

Bezpiecze stwo u ycia

Monta i pod czanie

Obs uga interfejsu
u ytkownika

Konfiguracja
systemu operacyjnego

Przygotowanie HMI do
projektu

Konserwacja i serwis

Specyfikacja techniczna

Dodatek

Wykaz skrotow

W > 0 ([N o o |~ [w N




Wa ne informacje
Wskazowki Bezpiecze stwa

Podr cznik zawiera uwagi, na ktére musisz zwréci uwag , by zapewni bezpiecze stwo osobiste, jak rownie
zapobiec zniszczeniu mienia. Uwagi odnosz ce si  do bezpiecze stwa wasnego s zaznaczone w podr czniku za
pomoc symbolu bezpiecze stwa, uwagi odnosz ce si do uszkodzenia mienia nie posiadaj symbolu
ostrzegawczego. Te uwagi pokazane poni €j s U0 one zgodnie ze stopniem zagro enia.

A NEBEZPIECZE STWO

wskazuje, e smier lub trwa e kalectwo nast pi je li nie zastosuje si  rodkéw bezpiecze stwa

A OSTRZE ENIE
wskazuje, e smier lub trwa e kalectwo mog nast pi je li nie zastosuje si  rodkéw bezpiecze stwa

A UWAGA
z symbolem niebezpiecze stwa wskazuje, e mog nast pi uszkodzenia cia a operatora

UWAGA
bez symbolu niebezpiecze stwa wskazuje, e mo e nast pi uszkodzenia obs ugiwanego sprz tu

NOTA

wskazuje, e niezamierzone wyniki lub nieoczekiwana sytuacja mo e nast pi je li nie we mie si pod
uwag za czonejinformaciji

Je liwi cejni jeden stopie zagro enia jest obecny, zostanie u yty najwy szy symbol z istniej cych zagro e .
Ostrze enie trwa ego okaleczenia z symbolem niebezpiecze stwa mo e zawiera tak e ostrze enie o mo liwym
zniszczeniu mienia, sprz tu.

Wykwalifikowany personel
Urz dzenie/system mog by ustawiane i u ywane tylko w po czeniu z t dokumentacj . Zlecanie
i u ytkowanie urz dzenia/systemu mo e by tylko wykonany przez wykwalifikowany personel.
W kontek cie bezpiecze stwa w tej dokumentacji, personel wykwalifikowany jest definiowany jako osoby, ktére
s upowa nione do zlecania, uziemiania i oznaczania urz dze , systeméw i obwodéw
z zachowaniem standardoéw bezpiecze stwa.

Odpowiednie u ywanie produktéw Siemens
Zapami taj:

A OSTRzZE ENIE

Produkty Siemens mog by u ywane tylko w aplikacjach opisanych w katalogu oraz odpowiednich
dokumentacjach technicznych. Je li u ywane s komponenty innych producentéw, musi by to zatwierdzone lub
rekomendowane przez Siemens. Odpowiedni transport, przechowywanie, instalacja, przygotowanie,
u ytkowanie oraz konserwacja s niezb dne by zapewni bezpieczne oraz bezawaryjne dzia anie produktu.
Dozwolone warunki otoczenia musz by réwnie speniane. Nale y zwréci uwag na odpowiedni
dokumentacj .

Znak handlowy

Nazwy oznaczone symbolem ® s zarejestrowanymi znakami handlowymi firmy Siemens AG. Inne nazwy u yte
w tej dokumentacji mog by znakami handlowymi, ktérych u ycie przez inne firmy do ich wasnych celéw mog
naruszy prawa autorskie.

Sprostowanie Odpowiedzialno ci

Przejrzeli my zawarto tej publikacji by zapewni zgodno z opisanym sprz tem i oprogramowaniem.
Ze wzgl du na to, e nie mo na wyeliminowa wszystkich niezgodno ci, nie mo emy zagwarantowa pe nej
zgodno ci. Jednak e, informacje w tej publikacji s przegl dane regularnie i ka da niezb dna poprawka jest
zawarta w kolejnych edycjach.
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Cel instrukcji u ytkowej

Instrukcja u ytkowa dostarcza informacji zgodnie z wymogami zdefiniowanymi przez IEC
62079 dla dokumentacji. Informacje odnosz sie do urz dzenia HMI, jego przechowywania,
transportowania, miejsca u ycia, instalacji, u ytkowania oraz konserwacji.

Instrukcja u ytkowa jest przeznaczona dla ré nych grup docelowych. Poni sza tabela
przedstawia sekcje instrukcji u ytkowej, ktére s szczegolnie wa ne dla odpowiednich grup

docelowych.

Grupa docelowa Sekcja

Wszyscy "Instrukcje bezpiecze stwa"
Operatorzy

"Przegl d"

Operatora u ytkuje oraz monitoruje system "U ytkowanie projektu”

podczas fazy kontroli procesu.

In ynierowie przygotowuj cy Wszystkie sekcje.

In ynierowie przygotowuj cy integruj urz dzenie W zale no ciodu ycia urz dzenia HMI,
HMI z systemem oraz zapewniaj zdolno niektére rozdziay nie musz by znane przez
u ytkow urz dzenia HMI podczas fazy kontroli in yniera przygotowuj cego np. sekcja
procesu. "Konserwacja i serwis".

Technicy serwisuj cy Wszystkie sekcje.

Technicy serwisuj cy poprawiaj b dy, ktére W zale no ciodu ycia urz dzenia HMI,
pojawiy si  podczas fazy kontroli procesu. niektére rozdziay nie musz by znane przez

technika serwisuj cego np. sekcja
"Konserwacja i serwis".

Technicy konserwacji "Konserwacja i serwis"

Technicy konserwacji wykonuj konserwacj i
serwis w czasie fazy kontroli procesu.

Pomoc zintegrowana w WinCC flexible, System Informacji WinCC, zawiera szczeg6 owe
informacje. System Informacji WinCC flexible zawiera instrukcje, przyk ady oraz podr czne
informacje w formie elektronicznej.

Zakres instrukcji u ytkowej

Instrukcja u ytkowa dotyczy urz dze HMI KTP400 Basic, KTP600 Basic, KTP1000 Basic
oraz TP1500 Basic w po czeniu z oprogramowaniem WinCC flexible.

Wymogi podstawowej wiedzy

Ogolna wiedza o technologii automatyzacji i komunikacji proceséw jest potrzebna do
zrozumienia instrukcji u ytkowej.

Niezb dna jestte wiedza o dzia aniu komputera oraz systeméw operacyjnych.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Zdj cia
Zdj cias czasem u ywane w instrukcji u ytkowej, aby zilustrowa urz dzenie HMI.
Nowsze wersje produktu mog si ré ni od tych na zdj ciach.

Konwencje

Poni sze formy graficzne maj nast puj ce znaczenie u ytkowe:

Forma graficzna Opis

Je liinstrukcja zawiera kilka zada ,
I kolejne indywidualne zadania s
Ak f'i\,l wskazywane przez cyfr w
[ .
pomara czowym ké ku.
<032 Jasno niebieskie pod wietlenie
! wskazuje komponenty oraz narz dzia
Mm niezb dne do wykonania zadania.
' Instrukcje bezpiecze stwa s

wskazywane przez pomara czow
ramk .

KTP600 Basic jak pokazano na rysunku
reprezentuje wszystkie urz dzenia HMI.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
Instrukcja u ytkowa, 01/2009, A5SE02421799-01
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Poni sze formy teksu oznaczaj

instrukcje operacyjne:

Forma przedstawienia Znaczenie

"Add screen” Terminologia, ktéra pojawia si w interfejsie u ytkownika,
np. nazwy okien, zak adek, przyciskow
Wymagany wpis, np. warto ci limitéw, warto ci zmiennych
Informacje o cie ce

"File > Edit" Sekwencja u ycia, np. komendy menu, menu kontekstowe

<F1> Operacje klawiaturowe

Konfiguracja i oprogramowanie wykonawcze ré ni si od siebie, zale nie do ich nazw:

"WinCC flexible 2008," na przyk ad, odnosi si do oprogramowania
konfiguracyjnego. Termin "WinCC flexible" jest u ywany w ogélnym kontek cie.
Pe na nazwa, na przyk ad "WinCC flexible 2008", jest zawsze u ywana gdy jest
potrzeba odrd nienia ré nych wersji oprogramowania wykonawczego.

"WinCC flexible Runtime" odnosi si do oprogramowania wykonawczego, ktore
mo e pracowa ha urz dzeniach HMI.

Prosz zwré uwag na uwagi etykietowane w nast puj cy sposéb:

Nota

Noty zawieraj istotne informacje o opisywanym produkcie, jego u ycia lub okre lonegj
sekcji dokumentacji, na ktér powiniene zwr6ci uwag .

Znak handlowy

Nazwy oznaczone symbolem ® s zarejestrowanymi znakami handlowymi firmy Siemens AG.
Inne nazwy u yte w niniejszej dokumentacji mog by znakami handlowymi, ktérych u ycie
do w asnych celéow mo e naruszy prawaw a ciciela.

¢ HMI®

¢ SIMATIC®

¢ SIMATIC HMI®

* SIMATIC ProTool®

¢ WinCC®

* SIMATIC WiInCC flexible®

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
Instrukcja u ytkowa, 01/2009, A5E02421799-01
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Informacje dodatkowe

Dodatkowe informacje o produktach opisanych w podr czniku mo esz znale w réd ach wg
poni szej tabeli:

Wymagania Kontakt

Kontakt z osobami oraz po o enie biur "http://www.siemens.com/automation/partner”
Dodatkowa dokumentacja techniczna "http://www.automation.siemens.com/portal/index.htm"
Centrum szkoleniowe "http://sitrain.automation.siemens.com/sitrain/"
Wsparcie techniczne "http://support.automation.siemens.com"

Formularz wsparcia online "http://www.siemens.com/automation/support-request"”
Serwis "http://www.siemens.com/automation/service"

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Przegl d 1

11 Przegl d produktu

Skupione na podstawach — nowe proste panele

W dzisiejszych czasach, wizualizacja jest standardowym elementem wi kszo ci maszyn.
W tym wypadku najwi ksz rol odgrywa czynnik ekonomiczny, zw aszcza dla niewielkich
maszyn oraz prostych aplikacji. Urz dzenia HMI z podstawowymi funkcjami s zazwyczaj
w pe ni wystarczaj ce dla takich wa nie prostych zastosowa .

To jest wa nie wymaganie, ktére chcemy spe ni — za pomoc naszych nowych Paneli
SIMATIC Basic. Przez skupienie si na podstawach, urz dzenia HMI z lini Basic oferuj
dok adnie te proste funkcje, ktére s potrzebne — wraz z dogodnymi warunkami
ekonomicznymi. Doskona y stosunek kosztéw do wydajno ci.

Jak wszystkie urz dzenia z naszego katalogu produktéw, nowe Panele Basic oferu;j
dowiedzion jako SIMATIC oraz — niezale nie od rozmieréw wy wietlacza — liczne
funkcje programowe, na przyk ad system alarmoéw, zarz dzanie recepturami, wy wietlanie
trendéw oraz zmianaj zyka. Dzi ki temu, nawet w prostych aplikacjach u ytkownicy czerpi
profity z przewag wizualizaciji takich jak np. zwi kszona jako procesu.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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1.2 Wygl d KTP400 Basic

1.2
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Wygl d KTP400 Basic
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@
@
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®

Wn ki na zaczepy monta owe
Wy wietlacz / ekran dotykowy
Uszczelka

Szyny na paski etykiet
Przyciski programowalne

Pod czenie uziemienia
Interfejs PROFINET
Gniazdo réd a zasilania
Tabliczka znamionowa

CRCRONSNT

Nazwa interfejsu
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1.3 Wygl d KTP600 DP Basic

13 Wygl d KTP600 DP Basic

3
0
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D)

Wy wietlacz / ekran dotykowy Tabliczka znamionowa
Wn ki na zaczepy monta owe
Uszczelka

Przyciski programowalne
Interfejs RS-422/485

Gniazdo réd a zasilania

Nazwa interfejsu
Prze cznik DIP
Szyny paskéw etykiet

2eeea

Pod czenie uziemienia
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1.4 Wygl d KTP600 PN Basic

1.4
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Wygl d KTP600 PN Basic

0 eee e

Wy wietlacz / ekran dotykowy
Wn ki na zaczepy monta owe
Uszczelka

Przyciski programowalne
Interfejs PROFINET

Gniazdo rdd a zasilania
Tabliczka znamionowa
Nazwa interfejsu

Szyny dla paskéw etykiet
Pod czenie uziemienia
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1.5 Wygl d KTP1000 DP Basic

15 Wygl d KTP1000 DP Basic

¢ ¥ ¥ £ ¥ ¥ ¢

Wy wietlacz / ekran dotykowy Tabliczka znamionowa
Prze cznik DIP

Nazwa interfejsu

Wn ki na zaczepy monta owe
Uszczelka

Przyciski programowalne
Interfejs RS-422/485

Gniazdo rdd a zasilania

Element monta owy
Pod czenie uziemienia

®eeeEee
Beeeea

Szyny dla paskow etykiet

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
Instrukcja u ytkowa, 01/2009, ASE02421799-01 15



Przegl d

1.6 Wygl d KTP1000 PN Basic

1.6 Wygl d KTP1000 PN Basic

Wy wietlacz / ekran dotykowy

Wn ki na zaczepy monta owe
Uszczelka

Przyciski programowalne
Interfejs PROFINET

Gniazdo réd a zasilania

o eEe e
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Tabliczka znamionowa
Nazwa interfejsu
Element mocuj cy

Pod czenie uziemienia
Szyny dla paskéw etykiet
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1.7 Wygl d TP 1500 Basic

1.7 Wygl d TP1500 Basic

Wy wietlacz / ekran dotykowy
Wn ki na zaczepy monta owe
Uszczelka

Interfejs PROFINET

Gniazdo réd a zasilania

Tabliczka znamionowa
Nazwa interfejsu
Element mocuj cy

@ @0

Pod czenie uziemienia

@6eeee
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1.8 Zawarto  paczki produktu

1.8 Zawarto paczki produktu

Nast puj ce komponenty s zawarte w paczce z urz dzeniem HMI.

Nazwa | Rysunek llo
Urz dzenie - 1
HMI

Instrukcje 1
instalacyjne

Uszczelka 1

Za czona do KTP 600 oraz ju
podklejona do wszystkich innych

urz dze HMI.
Zaciski z rub g KTP400 Basic
dociskow
B KTP600 Basic
12 KTP1000 Basic
14 TP1500 Basic
Z czka 1
zasilania

18
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1.9 Akcesoria

1.9 Akcesoria

Poni sze akcesorias dost pne dlaurz dze HMI w Internecie na stronie
"http://mall.automation.siemens.com”. Z czka nie jest za czona do urz dzenia HMI.

Konwerter RS 422 na RS 232

Konwerter jest potrzebny do po czenia sterownikéw innych producentéw do Paneli
Basic DP. Pod cz konwerter RS 422 na RS 232 do interfejsu RS 422 / RS 485.
Konwerter dostosowuje sygna wej ciowy do sygna 6w RS-232.

Numer zamoéwienia: 6AV6 671-8XE00-0AX0

Przewod PC/PPI

Przy aktualizacji systemu operacyjnego z przywracaniem ustawie fabrycznych potrzebny
jest przewdd PC/PPI. Mo esz réwnie u y przewodu do transferu. Pod c¢z przewdéd
PC/PPI do portu RS 422/485. Przewod dostosowuje sygna wej ciowy do sygna 6w RS 232.

Numer zamowienia: 6ES7 901-3CB30-0XA0

Nota

Je lipo czenie zostanie zerwane podczas aktualizacji systemu, ustaw ni sz szybko
bitéw. Je li chcesz komunikowa si z wi ksz szybko ci , musiszu y wersji 3 lub
pé niejszej, przewodu PC/PPI. Kod wersji przewodu jest drukowany na przewodzie
(np. "E-Stand 3" odpowiada wersji 3).

Przew6d USB/PPI

Przy aktualizacji systemu operacyjnego z przywracaniem ustawie fabrycznych potrzebny
jest przewdd USB/PPI. Mo esz réwnie u y przewodu do transferu. Pod c¢z przewéd
USB/PPI do portu RS 422/RS 485. Przewod zamienia sygna wej ciowy na sygna USB.

Numer zamowienia: 6ES7 901-3DB30-0XA0

Adapter k towy 90°
Mo eszu y adaptera k towego interfejsu RS 422/RS 485 by operowa w maych
przestrzeniach. Numer zaméwienia.: 6AV6 671-8XD00-0XA0

Z czka magistrali PROFIBUS
Radzimy u ywania prostych z czek magistrali PROFIBUS.
Numer zaméwienia: 6GK1 500-0FC10

Z czka PROFINET RJ45
Pod czenie Paneli Basic PN do PROFINET wymaga z czki RJ45"IEFCRJ45Plug2x2".
Numer zaméwienia: 6GK1901-1BB10-2AA0

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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1.10 Uwierzytelnianie urz dzenia HMI

Ramka monta owa

Ramka monta owa jest dost pna by zapewni wsparcie wyci ciu monta owemu w razie
je limateria nie jest wystarczaj co mocny, dla urz dzenia KTP1000 HMI.

Numer zamowienia: 6AV6 671-8XS00-0AX0

Folia ochronna
Folie ochronne s dost pne dlaurz dze HMI pod nast puj cymi numerami zamowie :
* Folia ochronna dla KTP400 Basic: 6AV6 671-2EC00-0AX0
* Folia ochronna dla KTP600 Basic: 6AV6 671-2XC00-0AX0
» Folia ochronna dla KTP1000 Basic: 6AV6 574-1AD00-4CX0
» Folia ochronna dla KTP1500 Basic: 6AV6 574-1AD00-4EX0

1.10 Przygotowanie urz dzenia HMI

Ta sekcja zawiera przegl d zada wymaganych do przygotowania urz dzenia HMI.

Opis Sekcja

1. [Zapoznajsi z instrukcjami Bezpiecze stwo u ycia (Strona 21)
bezpiecze stwa.
Przygotuj urz dzenie HMI do monta u. Przygotowania (Strona 23)
Instaluj urz dzenia HMI. Monta urz dzenia HMI (Strona 28)
Pod cz obwdd ekwipotencjalny. Po czenie ekwipotencjalne (Strona 32)
Pod cz rdd o zasilania. Pod czanie rod a zasilania (Strona 34)
Pod cz PC konfiguracyjny. Pod czanie PC konfiguracyjnego (Strona 36)
Udost pnianie kana u danych na urz dzeniu Udost pnianie kana u danych (Strona 61)
HMI.
Przes anie projektu. Rozpoczynanie przesy u r cznie (Strona 67)
Po przes aniu projektu, od ¢z urz dzenie Pod czanie do PLC (Strona 39)
HMI od PC konfiguracyjnego i pod cz je do
PLC.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Bezpiecze stwo u ycia

21

Instrukcje bezpiecze stwa

Praca w szafie sterowania

A OSTRZE ENIE

Otwarty Sprz t
Urz dzenie HMI jest sprz tem otwartym. Oznaczato, e musiby zainstalowane w
szafce gdzie b dzie mo na je obs ugiwa tylko od strony panelu przedniego.

Dost p do szafki, w ktdrej jest zainstalowane urz dzenie HMI powinien by mo liwy
tylko za pomoc klucza lub odpowiedniego narz dzia i tylko dla personelu, ktory
otrzyma przeszkolenie lub jest upowa niony

Uwaga, Wysokie Napi cie

Otwarcie szafki czyni dost pnymi elementy pod wysokim napi ciem. Dotkni cie tych
cz cimo eby gro ne.Zawsze wy cz rdod o zasilania szafki zanim j otworzysz.

Promieniowanie wysokiej cz stotliwo ci

UWAGA

Niechciane stany u ytkowe

Promieniowanie wysokiej cz stotliwo ci, na przyk ad z telefonéw komorkowych mo e
wywo a hiepo dane stany u ytkowe.

Instalacja jak zamierzono

A OSTRZE ENIE

Instalowanie w maszynach, ktére spe niaj odpowiednie dyrektywy

Nie jest dozwolone by montowano urz dzenie HMI w maszynie, ktéra nie spe nia
wymogow Dyrektywy 98/37/EC. Do 29 Grudnia 2009: Maszyna, w ktérej
zamontowane jest urz dzenie HMI musi spe nia Dyrektyw Maszynow
2006/42/EC.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Bezpiecze stwo u ycia

2.2 Uwagi o u ytkowaniu

2.2

U yciew

Uwagi o u ytkowaniu

rodowisku przemys owym

Urz dzenie HMI jest zaprojektowane do u ytku w rodowisku przemys owym. Spe nia ono
poni sze standardy:

«  Wymagania standardéw emisji dla rodowiska przemys owego, EN 61000-6-4: 2007

«  Wymagania odporno ci ESD DIN EN 61000-6-2:2005

U ycie w obszarze mieszkalnym

Nota

Urz dzenie HMI nie jest przeznaczone do u ytku w obszarze mieszkalnym. U ytkowanie
urz dzenia HMI w obszarze mieszkalnym ma negatywny wp yw na odbiér radia/TV.

Je liurz dzenie HMI jest u ywane w obszarze mieszkalnym, musisz podj odpowiednie
rodki by zapewni Klas B odpowiadaj ¢ EN 55011 dla zak 6ce RF.

Odpowiednim rodkiem do osi gni cia limitu Klasy B dla zak 6ce RF jest, na przyk ad,
u ycie filtréw na liniach zasilaj cych

Potrzebna jest indywidualna akceptacja.

Noty o komunikacji

22

UWAGA

B dy komunikacji spowodowane konfliktem adreséw

B dy komunikacji mog pojawi si , je likilka urz dze w sieci posiadaten sam
adres magistrali lub adres IP.

Upewnij si , e twoje urz dzenie HMI ma przypisany unikalny w sieci adres.

Nota
Aktualizacja warto ci zmiennych w nast pstwie b du komunikacji

Je li komunikacja pomi dzy urz dzeniem HMI oraz PLC zostaje zak 6cona, wszystkie
warto ci zmiennych wy wietlane na urz dzeniu HMI zostan zast pione przez znak "#".

Kiedy komunikacja pomi dzy urz dzeniem HMI, a PLC zostanie przywrdcona, wszystkie
warto ci zmiennych zostan natychmiast automatycznie zaktualizowane. Czas cyklu dla
aktualizacji warto ci zmiennych znéw zaczyna si od "0".

Komunikacja Ethernet z Panelami Basic PN

Panele Basic PN obs uguj nast puj ce typy komunikacji:
» Podstawowe funkcj PROFINET dla uwierzytelniania oraz diagnostyki
« Standardowa komunikacja Ethernet

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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31 Przygotowania

3.1.1 Sprawdzanie zawarto ci opakowania

Sprawd zawarto opakowania pod k tem widocznych uszkodze , ktére mog y wyst pi
w trakcie transportu oraz kompletu elementéw.

UWAGA

Uszkodzone cz ci

Nie instaluj cz ci uszkodzonych w czasie przesy ki. W przypadku uszkodzonych cz ci,
skontaktuj si z przedstawicielem Siemensa.

Zawarto paczki jest opisana w sekcji Paczka produktu (Strona 18).

Zachowaj za czon dokumentacj w bezpiecznym miejscu. Dokumentacja nale y do
urz dzenia HMI i jest niezb dna przy ka dym uruchomieniu.

3.1.2 Sprawdzanie warunkow u ytkowania
Zwré uwag nanast puj ce aspekty przed instalowaniem urz dzenia HMI:

1. Zapoznaj si ze standardami, aprobatami, parametrami EMC oraz specyfikacjami
technicznymi dotycz cymi operowania urz dzeniem HMI. Informacje te s dost pne
w nast puj cych rozdzia ach:

- Standardy, certyfikaty i aprobaty (Strona 91)

- Kompatybilno elektromagnetyczna (Strona 92)
- Testy izolacji, klasa i stopie ochrony (Strona 97)
- rod o zasilania (Strona 98)

2. Sprawd mechaniczne oraz klimatyczne warunki zewn trzne dla operowania
urz dzeniem HMI; zobacz Warunki u ycia (Strona 95).

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Monta ipod czanie

3.1 Przygotowania

3.1.3 Wybieranie pozycji monta u

Wybierz jedn z zatwierdzonych pozycji monta u dla swojego urz dzenia HMI. Aprobowane
pozycje monta u s opisane w poni szych sekcjach.

Pozycje monta u pionowego

Wszystkie urz dzenia HMI Basic s
odpowiednie do monta u poziomego.

TOUCH

Nast puj ce urz dzenia HMI HMI's réwnie
odpowiednie do monta u pionowego:

- KTP400 Basic .
- KTP600 Basic

Pozycje monta u pionowego

50 °C
0°C

0°-35*"0°-35°

Urz dzenia HMI Basic s samo wentyluj ce.
Pionowe oraz sko ne montowanie jest
dozwolone w:

¢ Szafkach monta owych
e Szafach sterowania

¢ Tablicach kontrolnych

¢ Konsolach

A UWAGA

uznane za niewa ne.

Przekraczanie temperatury otoczenia

Wymuszona wentylacja jest wymagana, je limo e zosta przektoczona
maksymalna dozwolona temperatura otoczenia HMI. Brak wentylacji mo e
doprowadzi do uszkodzenia urz dzenia HMI a jego aprobaty i gwarancje b d

Zobacz réwnie
Warunki u ycia (Strona 95)
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Monta ipod czanie

3.1 Przygotowania

3.1.4 Sprawdzanie miejsca

Wokoé urz dzenia HMI, do celéw wentylacji nale y zapewni wolne przestrzenie:

Wymagana przestrze woko
urz dze HMIL.

Wszystkie wymiary s w mm

o By 2
KTP400 (15 |40 | 10
KTPGOD (15 40 | 10
KTP1000 15 | 50 || 10
TF1500 BGE Sl i

3.15 Otwor monta owy

UWAGA

Stabilno  otworu monta owego

Materia w obszarze otworu monta owego musi by wystarczaj co silny by
zagwarantowa trwao oraz bezpiecze stwo monta u urz dzenia HMI.

Aby uzyska stopnie ochrony opisane poni ej, nacisk zaczepéw lub operowania
urz dzeniem nie mo e prowadzi do deformacji materia u.

Stopnie ochrony

Stopnie ochrony urz dzenia HMI mog by gwarantowane tylko je li spe nione
zostay nast puj ce wymagania:

e Grubo materiauw wyci ciu monta owym dla stopnia ochrony IP65 lub dla
za cznika typ 4X/typ 12 (do u ytku wewn trz): 2 mm do 6 mm

» Dozwolone odchylenie od powierzchni przy wyci ciu monta owym: < 0.5 mm
Ten warunek musi by spe niony dla zamontowanego urz dzenia HMI.

e Dozwolona nieréwno  powierzchni w obszarze uszczelki: < 120 urn (R, 120)

Ramka monta owa jest dodatkowo dost pna do monta u dla paneli KTP1000 Basic z
grubo ci materiau w wyci ciu monta owym < 2 mm. Rama pozwala na osi gni cie
stopnia ochrony IP65 lub za cznika klasy ochrony typ 4X/typ 12.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
Instrukcja u ytkowa, 01/2009, A5E02421799-01 25



Monta ipod czanie

3.1 Przygotowania

Zgodno monta owa

Otwory monta owe paneli Basic s zgodne z otworami nast puj cych urz dze HMI

SIMATIC:

Otwér monta owy dla Paneli Basic Zgodne z otworami dla innych urz dze HMI
KTP400

KTP600 TP 177 A, TP 177B 6", TP 177micro

KTP1000 MP 277 10" Touch, MP 377 12" Touch

TP1500 MP 377 15" Touch, Thin Client 15" Touch

Wymiary wyci cia monta owego

P s e R

Wymiary otworu monta owego dla urz dze
HMI Basic przy monta u poziomym:

W g h g

KTP400 123 o9
KTPEOD 197 141
KTP1000 310 248
TP1500 367 289

Wymiary otworu monta owego dla urz dze
HMI Basic przy monta u pionowym:

Wog h g

KTP400 88 123
KTFP&00 141 197

Wszystkie wymiary s w mm

Zobacz rownie
Akcesoria (Strona 19)
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Monta ipod czanie

3.1.6 Etykiety przyciskdw programowalnych

3.1 Przygotowania

Nota

Nie opisuj bezpo rednio / na przyciskach programowalnych.

Ka da folia, na ktérej mo na drukowa lub pisa mo e by u yta jako pasek etykiety.
Dozwolona grubo  paska etykiety to 0.15 mm. Papier nie jest odpowiednim materia em.

I

2
—
u'[
o
4 s5min
6

Edytuj szablon na PC. Szablony

s dost pne na CD_3\

Documents\<language>\Slides na
p ycie DVD WiInCC flexible.

. Wydrukuj edytowane szablony na

folii.

. Spryskaj paski etykiet sprayem

monta owym.

. Odczekaj oko 0 5 minut, a spray

monta owy wyschnie i b dzie
odporny ha zmazywanie.

. Wytnij paski etykiet.
. Odetnij rogi paskow etykiet pod

k tem 45° by u atwi ich
umieszczanie.

. Wsu paski etykiet w kiesze , a

do ko ca szyny.

Paski etykietb d wystaway

oko 0 3 cm z szyny. Wymiary
szablondw paskow etykiet s
zaprojektowane tak, aby pasoway
do przyciskow programowalnych.
Nie jest konieczne zabezpieczanie
paskow etykiet.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.2 Monta urz dzenia HMI

3.2 Monta urz dzenia HMI

Wymagane narz dziai akcesoria

Przed rozpocz ciem monta u, upewnij si , e posiadasz nast puj ce narz dzia i akcesoria:

P aski rubokret, rozmiar 2

Zaczepy monta owe

- KTP400 Basic: 5

- KTP600 Basic: 6

- KTP1000 Basic: 12
- TP1500 Basic: 14

Umieszczanie urz dzenia HMI

1. Je li konieczne, umie
uszczelk w rowku z ty u
przedniego panelu urz dzenia
HMIL.

Upewnij si  czy uszczelka nie jest
skr cona. Poprawnie umieszczona
uszczelka jest wymagana by
zapewni stopie ochrony IP65.

2. Umie urz dzenie HMI od przodu
W Wyci ciu mona owym.

Upewnij si , e wystaj ce paski
etykiet nie dostay si pomi dzy
wyci cie monta owe, a urzadzenie
HMI.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Monta ipod czanie
3.2 Monta urz dzenia HMI

Zabezpieczenie urz dzenia HMI

1. Umie pierwszy zaczep w pierwszej
pozycji we wn ce z ty u urz dzenia HMI.

Ustaw zaczepy w pozycjach dla swojego
urz dzenia HMI, by pasoway do tych na
rysunkach poni ej.

2. Zabezpiecz zaczepy za pomoc
rubokr ta o rozmiarze 2. Maksymalny
moment obrotowy to 0.2 N/m.

3. Powtdrz kroki 1 oraz 2 dla wszystkich
zaczepow wymaganych do
zabezpieczenia twojego urz dzenia HMI.

2-3 11-12 20-21

-

KTF1000

ITTTTIIT
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3.3 Pod czanie urz dzenia HMI

3.3 Pod czanie urz dzenia HMI

3.3.1 Kolejno pod czania

Wymagane narz dziai akcesoria

Przed rozpocz ciem pod czania urz dzenia HMI, upewnij si , e posiadasz nast puj ce

narz dzia i akcesoria:

rubokr t:
- rubokr t p aski, rozmiar 2
- rubokr t Philips, rozmiar 3
- rubokr t gwiazdkowy (Torx), rozmiar 3
Zaciskarka

Z czka zasilania

24 VDC z odpowiednim nat eniem pr du
Zobacz Specyfikacje (Strona 105)

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Procedura

3.3 Pod czanie urz dzenia HMI

Zachowaj poni sz kolejno zada przy pod czaniu urz dzenia HMI:

L

Po czenie ekwipotencjalne (Strona 32)

2. Pod czanie rdd a zasilania (Strona 34)
3.
4. Pod czanie PLC (Strona 39)

Pod czanie PC konfiguracyjnego (Strona 36)

UWAGA

Zmniejszenie napr enia

Zaciski mog zosta uszkodzone, a druty zerwane je li przewodom nie zapewni si
odpowiedniego zmniejszenia napr enia.
Zapewnij odpowiednie zmniejszenie napr enia dla wszystkich przewodéw.

Zobacz réownie

Zabezpieczanie przewodéw (Strona 43)

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3 Pod czanie urz dzenia HMI

3.3.2

Po czenie ekwipotencjalne

RO nica potencja 6w

RO nice potencja 6w wyst puj ce mi dzy oddalonymi elementami systemu sterowania mog
doprowadzi do pop yni cia w magistralach danych pr déw wyréwnawczych, ktére mog
uszkodzi ich interfejsy. Taka sytuacja mo e pojawi si , gdy ekran przewodu magistrali

Z obu stron pod czony jest do lokalnych mas, ktére nie s po aczone przewodem
wyréwnawczym. Ré nice w potencjale mog pojawi si , gdy system jest pod czony do

ré nych sieci zasilaj cych.

Wymagania og6lne dla po czenia ekwipotencjalnego

32

Aby zapewni wolne od usterek u ytkowanie komponentow systemu elektronicznego,
ré nice w potencja 6w musz by zredukowane przez zastosowanie po czenia
ekwipotencjalnego pomi dzy komponentami. Przy instalowaniu po czenia
ekwipotencjalnego nale y wzi  pod uwag :

Efektywno po czenia ekwipotencjalnego ro nie wraz ze spadkiem impedancji
przewodnika u ytego do po czenia lub ze wzrostem jego przekroju poprzecznego.

Je lidwa elementy systemu s po czone ze sob po przez ekranowane przewody
danych z ekranami pod czonymi do przewodnika uziemiaj cego/ochronnego po obu
stronach, impedancja dodatkowo zainstalowanego przewodu po czenia
ekwipotencjalnego nie mo e przekracza 10% impedancji ekranowe;.

Przekréj poprzeczny wybranego przewodnika po czenia ekwipotencjalnego musi by
zdolny do wytrzymania maksymalnego pr du wyrbwnawczego. Najlepszym

rozwi zaniem po czenia ekwipotencjalnego (iwc')ch szafek jest przewodnik

0 minimalnym przekroju poprzecznym 16 mm®.

Do po czenia ekwipotencjalnego u ywaj przewodnikéw z miedzi lub stali galwani-
zowanej. Zapewnij po czenie o du ej powierzchni pomi dzy przewodnikiem po -
czenia ekwipotencjalnego, a przewodnikiem uziemiaj cym, i chro je przed korozj .

Zako cz ekrany przewodow danych w urz dzeniu HMI znajduj ce si blisko szyny
ekwipotencjalnej przy pomocy odpowiednich zaciskow.

Wyznacz réwnoleg e cie ki dla przewodnika po czenia ekwipotencjalnego oraz
przewodu ekranowanego z minimaln odlego ci mi dzy nimi. Zobacz poni szy
schemat nod cze .

Przewod Po czenia Ekwipotencjalnego

Niea nale y stosowa ekran przewodu do po czenia ekwipotencjalnego. U ywaj
zawsze zalecanych przewodnikéw do po czenia ekwipotencjalnego. Minimalny przekroj
poprzeczny przewodu ekwipotencjalnego to 16 mm2. Gdy instalujesz sieci MPI oraz
PROFIBUS DP, zawsze u ywaj przewodow z wystarczaj cym przekrojem, gdy

w przeciwnym razie modu y interfejséw mog zosta uszkodzone lub zniszczone.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3 Pod czanie urz dzenia HMI

Procedura

1. Pod czmas urz dzenia HMI do
przewodu uziemiaj cego o przekroju
poprzecznym przewodu 4 mm>.

2. Pod cz przewdd uziemiaj cy
urz dzenia HMI do szyny po czenia
ekwipotencjalnego.

— PROFIBLS
_ PROFINET
<,

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic

33
Instrukcja u ytkowa, 01/2009, A5E02421799-01



Monta ipod czanie

3.3 Pod czanie urz dzenia HMI

3.3.3 Pod czenie rod a zasilania

Odizolowanie przewoddéw

U yj przewodéw zasilania o

1:,'5;:} maksymalnym przekroju przewodu
1.5 mm?.

i ﬁi /’ C:Sfﬂ 1. Odizoluj ko cowki obu przewodow

zasilania na d ugo ci 6 mm.

2. Umie ko cowki zaciskowe na
odizolowane przewody.

3. Zaci nij ko cowki na przewodzie za
pomoc zaciskarki.

Procedura

OSTRO NIE

Tylko 24 VDC

Niepoprawnie dobrane rod o zasilania mo e prowadzi do zniszczenia urz dzenia HMI.
U ywaj rod a zasilania 24 VDC z odpowiednim pr dem wyj ciowym, zobacz specyfikacje
(Strona 105).

1. Umie dwa przewody zasilania w
z czce zasilania i zabezpiecz je za
pomoc p askiego rubokr ta.

2. Pod czurz dzenie HMI do
z czki zasilania.

3. Wy cz rdd o zasilania.

4. Umie pozostae dwie ko cowki
przewodéw w z czce w rodle
zasilania i zabezpiecz je za pomoc
p askiego rubokr ta.

Upewnij si , e nie pomylie
polaryzacji.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.34 Pod czenie programatora
Programator zapewnia nast puj ce funkcje:
» Przesy anie projektow.

» Przesy anie obrazéw urz dzenia.

Pod czanie programatora do Panelu Basic DP

3.3 Pod czanie urz dzenia HMI

Nota
Programator nie mo e by u yty do przywrdcenia ustawie

fabrycznych na urz dzeniu HMI.

1.
2.
3.
PROFIBUS
RS 485

Wy cz urz dzenie HMI. Sprawd
czy prze cznik DIP na tylnym
panelu urz dzenia HMI jest w
nast puj cej pozycji:

4321

Flala™ o

Pod czz czk RS 485 PROFIBUS
do urz dzenia HMI.

Pod czz czk RS 485 PROFIBUS
do programatora.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3 Pod czanie urz dzenia HMI

3.35 Pod czenie PC konfiguracyjnego
PC konfiguracyjny dostarcza nast puj cych opciji:
« Przesy anie projektow.
» Przesy anie obrazow urz dzenia.

e Przywracanie ustawie fabrycznych na urz dzeniu HMI.

Pod czenie PC konfiguracyjnego do Panelu Basic DP

1. Wy czurz dzenie HMI.

2. Pod czz czk RS 485 przewodu PC/PPI
do urz dzenia HMIL.

3. Pod czz czk RS 232 przewodu PC/PPI do
PC konfiguracyjnego.

RS422/485 Mo esz réwnie u y przewodu USB/PPI z
zestawu akcesoriow zamiest przewodu PC/PPI.

Informacje o zaméwieniu mo esz znale w
rozdziale Akcesoria (Strona 19).

Serial

H5 232

1
/__-:\
PC

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Konfiguracja przewodu PC/PPI

3.3 Pod czanie urz dzenia HMI

Konfiguruj pr dko przesy u za pomoc prze cznikow DIP na przewodzie PC/PPI, je i
u ywasz przewodu PC/PPI by po czy urz dzenie HMI i PC konfiguracyjny.

Nota

Je lipo czenie zostanie przerwane podczas aktualizacji systemu ustaw mniejsz pr dko
Je liu ywasz wy szej pr dko ciprzesyu, musiszu y przewodu PC/PPI klasy 3 lub wy ej.
Kod wers;ji jest nadrukowany na przewodzie (np. "E stand 3," odpowiada klasie 3).

Ustaw prze czniki DIP od 1 do 3 na
takie same warto ci jak w WinCC
flexible. Prze czniki DIP od 4 do 8
musz by ustawione na "0". Na
rysunku ustawiona szybko to
115.2kbps.

You can set the following bit rates:

Szybko w kbps

DIP prze cznik 1

DIP prze cznik 2

DIP prze cznik 3

1152

57,6

384

19,2

9,6

4,8

2.4

1,2

| P O] O] O Of |

O| O| P P O| O| |

| Ol | Ol k| O], O
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3.3 Pod czanie urz dzenia HMI

Pod czenie PC konfiguracyjnego do Panelu Basic PN

UWAGA

Bezpiecze stwo danych sieciowych przy komunikacji przez Ethernet

Za zapewnienie bezpiecze stwa sieci danych w komunikacji opartej na Ethernecie,
takiej jak PROFINET, HTTP, Sm@rtAccess, Sm@rtService oraz OPC odpowiedzialni
s samijej u ytkownicy. Dzia anie urz dzenia w sieci nie mo e by zagwarantowane,
gdy mo e ononp. by przyczyn np.jejprzeci enia.

NOTA

Wymagana wtyczka RJ45 ze 180° wyj ciem

Pod czenie Paneli Basic PN do urz dzenia HMI wymaga wtyczki RJ45 "IE FC RJ45
Plug 2 x 2". Informacje o zamdwieniu mo esz znale w rozdziale Akcesoria
(Strona 19).

1. Wy czurz dzenie HMI.

1
; 2. Pod czz czk RJ45 przewodu LAN do
) urz dzenia HMI.

3. Pod cz drugi koniec przewodu LAN do

PROFINET (LAN J PC konfiguracyjnego.

L&

Lfuk

Zobacz rownie
Opcje przesy u danych (Strona 67)

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3.6 Pod czenie PLC

3.3 Pod czanie urz dzenia HMI

Pod czurz dzenie HMI do PLC, je li posiada ono system operacyjny oraz projekt

wykonawczy.

Pod czanie PLC do Panelu Basic DP

RS 422/485

PROFIBUS i
Dp

B | o

-__E
SIMATIC §7-200
SIMATIC 57-300/400

RS 422/485

RS 232

Third party PLC

Mo esz po czy Panele Basic DP
przez port RS 422/485 z

nast puj cymi sterownikami
SIMATIC:

- SIMATIC S7-200 .

- SIMATIC S7-300/400

Mo esz po czy Panele Basic DP z
nast puj cymi PLC przez konwerter
(z akcesoriow):

¢ Modicon Modbus

¢ Allen Bradley DF1

Po informacje o zamo6wieniu
konwerteréow odnie si do rozdziau
Akcesoria (Strona 19).

Je liu ywasz portu RS 422/485,
przeczytaj noty o konfiguracji w
niniejszym rozdziale.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3 Pod czanie urz dzenia HMI

Konfiguracja interfejsu RS-422/485

Prze cznik DIP dosu cy do konfigurowania interfejsu RS-422/485 jest zainstalowany na
tylnim panelu urz dzenia HMI.

Prze cznik DIP jest ustawiany fabrycznie by umozliwi komunikacj z SIMATIC PLC poprzez
RS 485.

Nota
Zwrd uwag na diagramy ustawie prze cznika DIP na tylnim panelu urz dzenia HMI.

Poni sza tabela przedstawia ustawienia prze cznika DIP. Kierunki nadawania i odbierania
S zmieniane wewn trznie za pomoc sygnau RTS.

Komunikacja Ustawienie prze cznikéw |Znaczenie
DP/MPI/PPI Nie ma sygnau RTS naz czce, dla wymiany
4321 danych pomi dzy SIMATIC PLC oraz urz dzeniem

HMI (stan fabryczny)

ﬁ

oM

Sygna RTS na pinie 4, tak jak na PLC,
przyk adowo do przygotowania pocz tkowego

Ja
[#5]
%

[ W~ H |~ | [
o)
=

o
=

Sygna RTS na pinie 9, tak jak na programatorze,
przyk adowo do przygotowania pocz tkowego

Interfejs RS-422/485 jest aktywny,
przyk adowo do pod czania PLC innej
firmy

RS 422/485

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.3 Pod czanie urz dzenia HMI

Pod czenie PLC do Panelu Basic PN

UWAGA
Bezpiecze stwo sieci danych przy komunikacji przez Ethernet

Za zapewnienie bezpiecze stwa sieci danych w komunikacji opartej na Ethernecie, takiej jak
PROFINET, HTTP, Sm@rtAccess, Sm@rtService oraz OPC odpowiedzialni s sami jej
u ytkownicy. Dzia anie urz dzenia w sieci nie mo e by zagwarantowane, gdy mo e ono

np. by przyczyn np.jejprzeci enia.

NOTA

Wymagana wtyczka RJ45 ze 180° wyj ciem

Pod czenie Paneli Basic PN do urz dzenia HMI wymaga wtyczki RJ45 "IE FC RJ45 Plug 2
x 2". Informacje o zamdéwieniu mo esz znale w rozdziale Akcesoria (Strona 19).

3 Panele Basic PN moga by pod czone do
g nast puj cych PLC SIMATICa:
52 - SIMATIC S7-200
- SIMATIC S7-300/400
- SIMATIC S7 z interfejsem PROFINET
Po czenie jest ustawiane przez PROFINET/LAN.

PROFINET (LAM)

PRDFNETi

FROFINET
LAN

| — |

=

[ —

SIMATIC 57-200
SIMATIC 57-300/400

Zobacz réwnie
Pod czanie obwodu ekwipotencjalnego (Strona 32)

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.4 W czanie i testowanie urz dzenia HMI

3.4 W czanie i testowanie urz dzenia HMI

W czanie urz dzenia HMI.

W czanie réd a zasilania.

Ekran rozja niasi pow czeniu zasilania.
Pasek post pu jest wy wietlany podczas rozruchu.

Je liurz dzeniu HMI nie uda si uruchomi ,
prawdopodobnie zamieniono przewody we
wtyczce zasilania. Sprawd pod czone przewody
oraz zmie ich pod czenie.

Po uruchomieniu systemu operacyjnego otwiera si Program aduj cy.

Naci nij przycisk "Transfer" by ustawi urz dzenie
=R | | ity Transer”

Tryb transferu mo e by aktywowany tylko je li
przynajmniej jeden kana danych zosta

Transfer udost pniony do przesy u.

Naci nij przycisk "Start" by rozpocz  projekt na
urz dzeniu HMI.

Je li nie wykonasz adnej operacji, projekt zostanie
Start uruchomiony automatycznie po up ywie czasu
opd nienia.

Naci nij przycisk "Control Panel" by otworzy
Panel Sterowania urz dzenia HMI. Mo esz
dokona r6 nych zmian w Panelu Sterowania, na
przyk ad ustawie przesy u.

Control Panel

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.5 Zabezpieczanie przewodow

Wy czanie urz dzenia HMI
1. Zamknij wszystkie aktywne projekty na urz dzeniu HMI.
2. Wy czurz dzenie HMI. Mo esz to zrobi w nast puj cy sposéb:
- Wy czy rdédo zasilania.

- Usun z czke zasilania z urz dzenia HMI.

3.5 Zabezpieczanie przewodéw
Nast puj ce urz dzenia HMI s wyposa one w element mocuj cy ztyu by unikn  napr e :
e KTP1000 Basic DP
« KTP1000 Basic PN
e TP1500 Basic

Po testowaniu zasilania, by unikn  napr e , u yj opasek zaciskowych by zabezpieczy
pod czone przewody do oznaczonego elementu mocuj cego.

5 | .E" | - Element
: mocuj ¢
e = I oy

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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3.5 Zabezpieczanie przewodéw

44
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Obs ugainterfejsu u ytkownika 4

4.1 Przegl d
Wszystkie urz dzenia HMI Basic posiadaj ekran dotykowy. Niektére z urz dze HMI
Basic posiadaj réwnie przyciski programowalne. U yj dotyku oraz przyciskow
programowalnych, aby u ytkowa Panel Sterowania lub dzia aj cy projekt na urz dzeniu
HMI.

ANIEBEZPIECZE STWO

B dnaoperacja

Projekt mo e zawiera pewne operacje, ktore wymagaj dog bnej wiedzy operatora
0 specyfice zak adu.

Upewnij si , e tylko wyszkolony profesjonalnie personel obs uguje zak ad.

Obs uga ekranu dotykowego

UWAGA
Uszkodzenie ekranu dotykowego
Ostre przedmioty mog uszkodzi plastikow powierzchni ekranu dotykowego.

Zawsze operuj ekranem dotykowym za pomoc swojego palca lub stylusa.
Wywo ywanie niezamierzonych akcji
Dotkni cie kilku kontrolek operatora jednocze nie mo e wywo a niezamierzone akcje.

Dotykaj jednorazowo tylko jednej kontrolki operatora.

Kontrolki operatoras wra liwymi na dotyk symbolami na ekranie urz dzenia HMI.

Mog by one u ywane tak jak przyciski mechaniczne. Aktywujesz kontrolki operatora
przez dotkni cie ich palcem.

Nota
Urz dzenie HMI zwraca odpowied wizualn jak tylko wykryje, e kontrolka operatora zosta a
dotkni ta.

Odpowied wizualna jest niezale na od jakiejkolwiek komunikacji z PLC. Dlatego odpowied
wizualna nie wskazuje czy odpowiednia akcja zosta a wykonana czy te nie.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Operowanie interfejsem u ytkownika

4.1 Przegl d

Przyk ad kontrolek operatora:
e Przyciski

Przyciskimog przyjmowa nast puj ce stany:

"Niedotkni ty" "Dotkni ty"

__| [

e Przyciski niewidzialne

Wyostrzenie niewidzialnych przyciskéw jest domy Inie nie wskazywane po zaznaczeniu.
W tym przypadku nie ma adnego sprz enia optycznego operaciji.

In ynier konfiguruj cy mo e skonfigurowa niewidzialne przyciski tak, aby po dotkni ciu
pojawia a si obwoddka. Pozostaje ona widoczna do czasu dotkni cia innej kontrolki
operatora.

« Polal/O

Klawiatura ekranowa pojawia si jako wizualna odpowied po dotkni ciu pola I/O, na
przyk ad by wprowadzi has o.

W zale no ciod urz dzenia HMI oraz od skonfigurowanych kontrolek operatora, system
wy wietla r6 ne klawiatury ekranowe do wprowadzania warto ci alfanumerycznych lub
numerycznych.

Klawiatura ekranowa jest automatycznie chowana po dokonaniu wpisu.

Nota
Opis wszystkich kontrolek operatora

Dok adny opis wszystkich kontrolek operatora Twojego urz dzenia HMI jest dostarczony
w pomocy Online WIinCC flexible w rozdziale "System alarms".

U ywanie przyciskéw programowalnych
Przyciskom programowalnym mo na przypisa funkcje globalne b d lokalne:
« Przyciski programowalne z przypisan funkcj globaln

Przycisk programowalny z przypisan funkcj globaln zawsze wywo ujet sam
akcj naurz dzeniu HMI lub w PLC, niezale nie od bierz co wy wietlanego ekranu.
Przyk adem takiej akcji jest aktywowanie ekranu lub zamkni cie okna alarmu.

e Przyciski programowalne z przypisan funkcj lokaln

Przycisk programowalny z przypisan funkcj lokaln jest okre lony dla konkretnego
ekranu i dlatego dzia a tylko w jego obszarze.

Przypisanie funkciji dla jednego przycisku mo e ré ni si mi dzy ekranami.

Przyciskowi progamowalnemu mo e by przypisana tylko jedna funkcja w obszarze jednego
ekranu, lokalna lub globalna. Przypisanie funkcji lokalnej ma priorytet przed przypisaniem
funkcji globalne;j.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Operowanie interfejsem u ytkownika

4.2 G 6wne funkcje klawiatury ekranowej

4.2 G 6wne funkcje klawiatury ekranowej

Dla wszystkich urz dze HMI Basic dost pne s nast puj ce przyciski na ekranach
dotykowych:

Kursor w lewo

It

Kursor w prawo

v

Usu znak

E

Anuluj wpis

I

Potwierd wpis

[t

Wy wietla infotekst. Ten przycisk pojawia si tylko, kiedy infotekst zosta
skonfigurowany dla kontrolki operatora.

|

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Operowanie interfejsem u ytkownika

4.3 Wprowadzanie danych na KTP400 Basic

4.3

48

Basic r6 nisi odinnych urz dze HMI Basic.

Wprowadzanie danych na KTP400 Basic

Ze wzgl du na may wy wietlacz, klawiatura oraz spos6b wprowadzania danych na KTP400

Text Text
| [ 5UN]
& B C 0 E H 5] P (o] | R
F I [ H 1 3 g 1 1 v | W
= I I M il L I I
Shf: | w2 og] -» >) shft| At pa| -
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v z 4 ; 1 2 | =
- ; = B { 4 5 i %
INE N 7 2 g ] 0
s wz| oo << &0 | K- et
4—| | e=n | Exc| g o—| | eBzp| Esc| gt

Klawiatura ekranowa pojawia si na ekranie dotykowym jak tylko dotkniesz kontrolki
operatora, ktéra wymaga wpisu.

Klawiatura ekranowa w KTP400 posiada cztery widoki. Mo esz zmienia widoki podczas
dokonywania wpisu u ywaj c przyciskow w czterech rz dach klawiatury ekranowej:

Przycisk Zmiany w widoku

Wprowadzanie tekstu, znakéw "A" do "M"
A=

Wprowadzanie tekstu, znakéw "N" do "Z"
M-

Wprowadzanie liczb, "0" do "9" z miejscami dziesi tnymi lub bez, oznaczone lub nie.
0-9

Wprowadzanie znakéw specjalnych
+

Wprowadzanie tekstu, zmienia na ma e litery
Shift

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Operowanie interfejsem u ytkownika

4.3 Wprowadzanie danych na KTP400 Basic

Nota

Skrzynka Pocztowa nieczynna

Opcja PLC 51 "Select screen” jest nieczynna, kiedy otwarta jest klawiatura ekranowa.
Przypisanie przyciskow

Klawiatura alfanumeryczna ekranowa jest jedno j zykowa.

Zmianaj zyka w projekcie nie powoduje adnych zmian w wygl dzie
alfanumerycznej klawiaturze ekranowe;.

Wprowadzanie warto ci alfanumerycznej

1. Dotknij okre lonej kontrolki operatora na
ER ekranie.

Otworzy si  alfanumeryczna klawiatura.
2. Wprowad warto ci. W zale no ci od

I | ustawie , urz dzenie HMIwysyad wi k.
& B _E‘J o E Mo esz zmieni widok klawiatury
g = = : 3 25\!‘_?\;']:\Nej u ywaj c przyciskow <N-Z> oraz
. L r Uyj p.rzycisku <Shift> by wprowadza
ma e litery.
T ..l 05 ] ¢ 3. Naci nij przycisk <Retum> by potwierdzi

wprowadzone zmiany, lub anuluj je za

Shift

G _:.'J E] = ".J pomoc <ESC>.
A
N

:ﬁi& Obie akcje zamykaj klawiatur ekranow .

=
2zl
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Operowanie interfejsem u ytkownika
4.3 Wprowadzanie danych w KTP400 Basic

Wprowadzanie warto ci humerycznych

1. Dotknij okre lonej kontrolki operatora

na ekranie.
1 Otwiera si numeryczna klawiatura
ekranowa.
2. Wprowad warto .W zale no ciod
I |

ustawie , urz dzenie HMI wysy a sygna

2 d wi kowa.
1 2 3 5= T . .
L) Mo esz zmieni widok klawiatury ekranowej
6 dla wprowadzania liczb z notacj
4 2 . | heksadecymaln u ywaj c przyciskow
l q <N-Z> oraz <A-M>.
7 8 9 0 3. Naci nij przycisk <Return> by potwierdzi
swoje wpisy, lub anuluj je za pomoc
AM | N-Z ) przycisku <ESC>.
Obie akcje zamykaj klawiatur ekranow .
4| —p| osp| esc ‘_Il ] y«a

Sprawdzanie limitbw warto ci numerycznych

Zmiennym mo e by przypisany limit warto ci. Ka da warto przekraczaj ca ten limit
zostaje odrzucona. Je li skonfigurowana jest kontrolka alarmu, wyzwolone zostaje zdarzenie
systemowe, awarto pocz tkowa zostaje wy wietlona ponownie.

Miejsca dziesi tne warto ci numerycznych

In ynier konfiguracyjny mo e zdefiniowa ilo miejsc po przecinku dla numerycznych pol
tekstowych. llo  miejsc po przecinku jest sprawdzana, kiedy wprowadza si warto tego
typu w polu we/wy (1/0 ).

Miejsca po przecinku, ktére przekraczaj limits ignorowane.

Niewykorzystane miejsca po przecinku s wype niane "0".

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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4.4 Wprowadzanie danych na KTP600, KTP1000, TP1500 Basic

4.4 Wprowadzanie danych na KTP600, KTP1000, TP1500 Basic

Alfanumeryczna klawiatura ekranowa

Klawiatura ekranowa pojawia si na ekranie dotykowym urz dzenia HMI, kiedy dotkniesz
kontrolki operatora wymagaj cej wprowadzania.

Text Mumbears
| SLIMT: | | FOHEF
4l B Eﬂf Fle|H]t] 3] A 1 a 3 e
wli|mlwlolelel®|slsl P o 75 | 6 | e
1] b 'ﬂ.'i! ¥ L il * = L
= ____T [ T B +
)= e ] e] o] | -

(0] E B
o] 2] 2] 2] a] 5| e] 7] o] ] L= ]
s.hrr|4— —lrl ast-l ESL| o 4= | —+ | Hip -
Nota

Skrzynka Pocztowa nieczynna
Opcja PLC 51 "Select screen” jest nieczynna, kiedy otwarta jest klawiatura ekranowa.
Przypisanie przyciskow

Klawiatura alfanumeryczna ekranowa jest jedno j zykowa.
Zmianaj zyka w projekcie nie powoduje adnych zmian w wygl dzie
alfanumerycznej klawiaturze ekranowe;.

Wprowadzanie warto ci alfanumerycznych

1. Dotknij okre lonej kontrolki operatora
na ekranie.

Otwiera si  alfanumeryczna klawiatura
ekranowa.

2. Wprowad warto .W zale no ciod

ustawie , urz dzenie HMI wysy a sygna
d wi kowy.

U yj przycisku <Shift> by wprowadzi mae
litery.

2. Naci nij przycisk <Retum> by potwierdzi
wprowadzone zmiany, lub przycisk
<ESC> by je anulowa .

Obie akcj zamykaj klawiatur ekranow .

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Operowanie interfejsem u ytkownika

4.4 Wprowadzanie danych na KTP600, KTP1000, TP1500 Basic

Wprowadzanie warto ci numerycznych

b 1 2 ESC)
B 4 5 BSP
C 7 8
D E F

4| —» Help -«

==

Dotknij okre lonej kontrolki
operatora na ekranie.

Otworzy si numeryczna klawiatura
ekranowa.

. Wprowad warto .W zale no ciod

ustawie , urz dzenie HMI wysy a sygna
d wi kowy.
Naci nij przycisk <Retum> by potwierdzi
wprowadzone zmiany, lub przycisk
<ESC> by je anulowa .

Obie akcj zamykaj klawiatur ekranow .

Sprawdzanie limitbw warto ci numerycznych

Zmiennym mo e by przypisany limit warto ci. Ka da warto przekraczaj ca ten limit
zostaje odrzucona. Je li skonfigurowana jest kontrolka alarmu, wyzwolone zostaje zdarzenie
pocz tkowa zostaje wy wietlona ponownie.

systemowe, a warto

llo cyfrwarto ci numerycznych

In ynier konfiguracyjny mo e zdefiniowa ilo
miejsc dziesi tnych jest sprawdzana, kiedy wprowadza si warto tego
typu w polu we/wy (1/0 ).

tekstowych. llo

Miejsca po przecinku, ktére przekraczaj

cyfr dziesi tnych dla numerycznych pol

limits ignorowane.

Niewykorzystane miejsca po przecinku s wype niane znakami "0".
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51 Otwieranie Panelu Sterowania

Conol Panal

Basic Panels DP

Control Panel

ﬂ]
Ly 3 B

Setings

{, B ®

Trans far ot TS T Seund Settings

Basic Pangls PN

Contral Pangl

»E & B

Profins F'ESSI.UON

fg B

Transfer Soreensaver  Sound Settings

Otworz Panel Sterowania przez naci ni cie
przycisku "Control Panel" w Programie aduj cym.

Skonfiguruj swoje urz dzenie HMI w Panelu
Sterowania. Mo esz zmieni nast puj ce
ustawienia::

¢ Ustawienia komunikacyjne
¢ Ustawienia u ytkowania

e Ochrona has em

« Ustawienia przesy u

* Wygaszacz ekranu

* Sygnay akustyczne

"MPI / Profibus Settings" jest dost pny tylko na
Panelach Basic DP.

"Profinet" jest dost pny tylko na Panelach Basic
PN.

Ochrona Panelu Sterowania za pomoc has a

Mo esz chroni Panel Sterowania przed nieautoryzowanymi operacjami. Mo esz odczytywa
ustawienia w Panelu Sterowania bez wpisywania has a, jednak nie mo esz edytowa tych

ustawie .

Zapobiega to niezamierzonym operacjom oraz podnosi bezpiecze stwo zak adu i
maszyn, gdy ustawienia nie mog by zmieniane.

UWAGA

Je lihasoniejestju du ejdost pne dla Panelu Sterowania, musisz najpierw
aktualizowa system operacyjny przed dokonywaniem zmian w Panelu Sterowania.

Wszystkie dane na urz dzeniu HMI s nadpisywane podczas aktualizacji systemu!

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Konfigurowanie systemu operacyjnego

5.2 Przegl d

5.2 Przegl d

Poni sza tabela pokazuje funkcje dost pne w Panelu Sterowania dla konfiguracji urz dzenia
HMI.

Symbol Funkcja
ﬁ Zmiana ustawie MPI/DP (Strona 55)

Zmiana konfiguracji sieciowej (Strona 56)

Zmiana ustawie monitora (Strona 57)

-

& WYy wietlanie informacji o urz dzeniu HMI (Strona 58)
i

4

L

Kalibrowanie ekranu dotykowego (Strona 59)

WYy wietlanie informaciji licencyjnych dla urz dzenia HMI (Strona 60)

Zmiana ustawie has a (Strona 63)

Udost pnianie kana u danych (Strona 61)

Ustawienia wygaszacza ekranu (Strona 64)

Ustawianie sygna 6w akustycznych (Strona 64)

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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5.3 Zmiana ustawie MPI/DP

5.3 Zmienianie ustawie MPI/DP

Nota

Ustawienia dla komunikacji MPI lub PROFIBUS DP s definiowane w projekcie urz dzenia
HMI. Edytuj ustawienia przesy u tylko w poni szych sytuacjach:

* Pierwszy przesy projektu.

* Zmiany dokonane w projekcie s aktywowane pé niej.

Contral Paniegl

5
0K
Staton Farameprs——mMmM8m ———
[ Panel i the only mester on e bus
Address: i [
2 Time-out I 1= ; AI
rMetwark Perametzrs: 3
Traremissnn Ral 1500 kBaud
Highest Stafort 125
Profie: j [T I
Al g
Euis Paramaiers. . |
Frodive EE 3R
Telot 414 thit
Fein Tedr; 18R
Motz Tadde. 430 eBiE
Taat: 13 180
Tigud: D it
Gap faamn & tait
Pary bmit: 2 thit

Naci nij przycisk "MPI / Profibus Settings" by
otworzy okno "MPI / Profibus Settings".

Deaktywuj pole wyboru "Panel is the only
master on the bus" je li do magistrali
pod czones dodatkowi "masters".

Wprowad adres magistrali dla urz dzenia
HMI w polu tekstowym "Address". Adres
magistrali musi by unikalny w ca ej sieci
MPI/PROFIBUS DP.

Woprowad limit czasu dla komunikaciji
PROFIBUS w polu wyboru "Time-out".
Poprawne warto cito1s, 10 s oraz 100s.

Wybierz szybko przesy u z pola wyboru
"Transmission Rate".

Wprowad adres najwy szej stacji w
magistrali w polu tekstowym "Highest
Station". Poprawny zakres warto ci: 1 do
126.

Wybierz profil z pola wyboru "Profile".

Naci nij przycisk "Bus Parameters..."
by przejrze dane profilu PROFIBUS.

Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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5.4 Zmienianie konfiguracji sieciowej

5.4

56

Zmiana konfiguracji sieciowej

UWAGA

B dy komunikacyjne spowodowane konfliktami adreséw IP
Je likilka urz dze w siecidzieliten sam adres IP mog pojawi Si

Ka demu urz dzeniu HMI przypisz unikalny adres sieciowy.

b dy komunikaciji.

R
A

wnds

0k
# address | | oo
20 1P exddress con be auicmatcaly
e 0 Tis device
Z} Chsaim an 1P address via GHCF
® Specily an P sddress

(132 [12e [18 [+
zsmtm:k: E3EAE3 N
Do a0 |0 | 0 | 0

1P Snerees |

Frafine] Selings

v.umm| Mok

Configure ransmission speed

Speed I 10 ihidsis

Comiranicaton Link
i Hot-Duglesy
3 Ful-Dugles:

G

WP ffiecs

[ |

Erder Stason Mams (nof mors fan 290 h'

characiers]

Sia%on Name

MAC Addréds.  D0-18-88-16-EA-DF

w =

1

2.

10.

Naci nij przycisk "Profinet" by otworzy okno
"Profinet Settings".

Wybierz albo automatyczne przypisywanie
adreséw przez DHCP, albo przypisywanie
r czne adresu.

Je li przypisujesz adres r cznie, u yj
klawiatury ekranowej do wprowadzenia
poprawnego adresu IP w pola tekstowe "IP
Address", "Subnet Mask" i je li dozwolone w
pole tekstowe "Default Gateway".

Prze cznazakadk "Mode".

Wprowad szybko przesy u dla sieci
PROFINET w pole tekstowe "Speed".
Dozwolone warto ci to 10 Mbps oraz
100Mbps.

Whybierz tryb po czenia "Half duplex” lub "Full
duplex".

Nast puj ca funkcja zostanie
aktywowana je li pole wyboru "Auto
Negotiation" zosta o zaznaczone:

- Trybpo czenia oraz szybko
zostan wykryte i ustawione
automatycznie dla sieci PROFINET.

- Funkcja "Auto-Crossover" zostanie
aktywowana, co oznacza, e urz dzenie
HMI mo e by pod czone do PC lub
sterownika bez dodatkowego przewodu
przej ciowego.

przesy u

Prze cz nazakadk "Device".

Wprowad nazw sieciow swojego
urz dzenia HMI. Nazwa musi spe hia
nast puj ce warunki.

- Maksymalna dugo : 240 znakéw
- Znaki specjalne: tylko "-" oraz "."

- B dnaskadnia: "n.n.n.n" (n=0 do
999) oraz "port-yxz" (x, y, z=0 do 9)

Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".
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55 Zmiana ustawie monitora

5.5 Zmienianie ustawie monitora

UWAGA

W przeciwnym razie zawarto

Orientacja ekranu dla KTP400 Basic oraz KTP600 Basic

Orientacja ekranu jest definiowana przez in yniera konfiguruj cego w czasie
tworzenia projektu. Odpowiedni ukad ekranu jest ustawiany automatycznie,
kiedy przesy asz projekt na urz dzenie HMI.

Nie wprowadzaj zmian w orientacji ekranu, je li na urz dzeniu HMI istnieje projekt.
ekranu mo e zosta okrojona.

Control Panel

riorientation: 1
@ Landscape KTP400
(2 Porirait @3
~Starup Delay
Delay ftme: 3 SEC
Al
4

Naci nij przycisk "OP" by otworzy
okno "OP Properties".

Panele Basic kolor:

Naci nij przyciski "UP" oraz "DOWN" by
dostosowa jasno ekranu.

Panele Basic mono:

Naci nij przycisk "UP" oraz "DOWN" by
dostosowa kontrast ekranu.

. Tylko dla KTP400 oraz KTP600:

Wybierz orientacj ekranu:
- "Portrait" dla pionowego
- "Landscape" dla poziomego

Ustaw czas op6 nienia w polu tekstowym
"Delay time". Czas opd nienia w sekundach
okre la czas pomi dzy pojawieniem si
Programu aduj cego a uruchomieniam
projektu.

Zakres warto ci: 0 s do 60 s.

. Zamknij okno i zapisz wprowadzone zmiany

za pomoc "OK".

Nota

Natychmiastowe uruchomienie projektu z czasem opd nienia 0 sekund

natychmiast, je li czas op6 nienia wynosi 0 sekund. Nie jest wtedy
mo liwe wywo anie Programu aduj cego pow czeniu urz dzenia HMI. By poradzi sobie z
t sytuacj , nale y skonfigurowa kontrolk operatora z funkcj "Close project".

Projekt uruchamia si

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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5.6 Wy wietlanie informacji o urz dzeniu HMI

5.6 Wy wietlanie informacji o urz dzeniu HMI

1. Naci nij przycisk "OP" by otworzy okno
"OP Properties"

Confrol Panel

2. Zmie nazakadk "Device".

Zak adka "License" jest u ywana do

wy wietlania okre lonych informacji na
urz dzeniu HMI. B dziesz potrzebowa
3 tych informacji, kiedy b dziesz si
kontaktowa ze wsparciem technicznym.

- "Device": nazwa urz dzenia HMI

- "Flashsize": Rozmiar wewn trznej
pami ci flash do ktérej zapisywane s
obraz urz dzenia HMI oraz projekt.
Rozmiar wewn trznej pami ci flash nie
odpowiada dost pnej pami ci aplikacji

Device WiIM3E2 simulation dla projektu.

"Bootloader": wersja Bootloader'a

CF Fropertie: | :'-"" ll-
Display | Device | Toueh | License |

Flashsize Unknawwn -

Bootioadsr o - "Bootl. Rel. Date": Data wydania boot
loader'a

e - "Image": Wersja obrazu urz dzenia HMI

Image 01.04.00 00_04 01

3. Zamknij okno za pomoc "OK."

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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5.7

Kalibracja ekranu dotykowego

5.7 Kalibrowanie ekranu dotykowego

v® o

Caraddly prass and biedy nol STHUS.on T oamer of
Tl Ganger. Faoad B T targaThioves around T Soeen

+@‘

i'@\k@"*

P ol ZoEban wE gl Dl v SEET T Eesrad
Tz e b2 reg e ived detl
Wk for 30 saconds o cncsl aved data @ nd
sz Hra curent sating

&)

Trrm imt: 5 mac

1. Naci nij przycisk "OP" by otworzy okno

"OP Properties".

2. Zmie nazakadk "Touch".

3. Naci nij przycisk "Recalibrate" by otworzy

ekran kalibrowania.

4. Dotknij krzy a na rodku ekranu, u ywaj c

stylusa (piérka) lub swojego palca.

5. U yj stylusa lub swojego palca by dotkn

krzy aw ka dym z rogéw ekranu.

9. Dotknij krzy a na rodku ekranu ponownie

by potwierdzi wprowadzone pozycje.

10. Zamknij okno i zapisz wprowadzone
pozycje za pomoc "OK".
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5.8 Wy wietlanie informacji licencyjnych dla urz dzenia HMI

5.8 Wy wietlenie informacji licencyjnych dla urz dzenia HMI

1. U yjprzycisku OP by otworzy
okno "OP Properties".

Sl
@ g 2. Otwérz zakadk "“License”.
| i‘ Zak adka licencji jest u ywana do

wy wietlania informacji licencyjnych dla
programow na urz dzeniu HMI.

Pirpiay | Dercics |
This devics catisns Daibuers, kearesd
undey & Fres Sgibeses Lioence; Thess
ernbeicd frod S0 beaont s ore: protscled

oy cogremghk, Plonae ind e Boensrg
oy mealon sndl s ce s ol Be open

g O e g OF: B mtcignatnng O,

Tousch ||.Inm¢ 3. Zamknij okno za pomoc "OK."

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic

60 Instrukcja u ytkowa, 01/2009, ASE02421799-01



Konfigurowanie systemu operacyjnego

5.9 Udost pnianie kana u danych

5.9 Udost pnianie kana u danych

Musisz udost pni przynajmniej jeden kana danych by przesa projekt do urz dzenia HMI.

Nota

Po zako czeniu przesy u projektu, mo esz chroni urz dzenie HMI przed
niezamierzonym nadpisaniem danych projektu oraz obrazu urz dzenia HMI przez

zablokowanie wszystkich kana éw danych.

Udost pnianie kana u danych — Panele Basic DP

Control Panel

Tranzfer Setings

Channel 1:
Seriat [< Enable Channel
2
Channel 2:

| PROFIBUS [~ Enable Channel

Advanced I~ Remaks Contro

4
5.3

1. Naci nij przycisk "Transfer" by

otworzy okno "Transfer Settings".

. Je liurz dzenie HMI jest po czony z PC

konfiguracyjnym przez przewéd PC-PPI,
Aktywuj pole wyboru "Enable Channel"
w polu "Channel 1".

Je liurz dzenie HMI jest po czone z
programatorem przez PROFIBUS, aktywuj
pole wyboru "Enable Channel" w polu
"Channel 2"

Naci nij przycisk "Advanced" by otworzy
okno "MPI / Profibus Settings". Sprawd
parametry PROFIBUS w tym oknie. Opis
okna "MPI / Profibus Settings" znajduje si
w rozdziale 5.3, Zmienianie ustawie
MPI/DP (Strona 55).

. Zamknij okno i zapisz wprowadzone zmiany

za pomoc "OK".

Nota

Przesy automatyczny jest aktywowany przez zaznaczenie pola "Remote Control". Je i
aktywowany jest przesy automatyczny, urz dzenie HMI mo e by ustawione w tryb przesy u

przez zdalny PC konfiguracyjny lub programator.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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5.9 Udost pnianie kana u danych

Udost pnianie kana u danych — Panele Basic PN

Control Panal 1. Naci nij przycisk "Transfer" by otworzy
okno "Transfer Settings".

2. Wybierz pole wyboru "Enable Channel"
w polu "Channel 1".

Naci nij przycisk "Advanced" by otworzy
okno "Profinet Settings". Sprawd parametry
sieci w tym oknie. Opis okna "Profinet
Settings" znajduje si w rozdziale 5.4,
Zmienianie konfiguracji sieciowej (Strona 56).

Tranzfer Setfing:

Channel 1:

Ethernet [ Enable Channel 3.

[ Remole Confrol

Zamknij okno oraz zapisz wprowadzone
zmiany za pomoc "OK".

N\
5.4

Nota

Przesy automatyczny jest aktywowany przez zaznaczenie pola "Remote Control”. Je i
aktywowany jest przesy automatyczny, urz dzenie HMI mo e by ustawione w tryb
przesy u przez zdalny PC konfiguracyjny lub programator.
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5.10 Zmienianie ustawie has a

5.10 Zmiana ustawie has a
Ochrona has em zapobiega nieautoryzowanemu dost powi do Panelu Sterowania.

UWAGA

Has o nie mo e zawiera znaku spacji lub znakoéw specjalnych * 2 . % /\".

Je lihasoniejestju du ejdost pne dla Panelu Sterowania, musisz najpierw
aktualizowa system operacyjny zanim b dziesz még wykona jakiekolwiek zmiany
w Panelu Sterowania. Wszystkie dane na urz dzeniu HMI zostan nadpisane, kiedy
aktualizujesz system operacyjny.

Procedura — Aktywowanie ochrony has em

Conirol Panel 1. Naci nij przycisk "Password" by otworzy
okno "Password Properties".

2. Wprowad has o w pole tekstowe
"Password". Dotknij pola tekstowego.
Wy wietlona zostaje klawiatura
alfanumeryczna.

3. Potwierd has o w polu tekstowym
"Confirm Password".

4. Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".

leimpessvm'ntl R

Procedura — Deaktywowanie ochrony has em

1. Naci nij przycisk "Password" by otworzy
okno "Password Properties".

2. Usu wpis w polu tekstowym "Password".

3. Usu wpis w polu tekstowym "Confirm
Password".

4. Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".

Confrol Fanel

Confirm password |
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5.11 Ustwianie wygaszacza ekranu

5.11

5.12

64

Ustawienie wygaszacza ekranu

UWAGA

Efekt wypalenia

Zawarto ekranu mo e pozostawi nieruchom wersj (duch)obrazub d cegowtleje li
jest on wy wietlany zbyt d ugo.

"Duch" zniknie sam po jakim czasie. Im du ej ta sama zawarto  jest wy wietlana na
ekranie, tym d u ej potrwa zanim efekt wypalenia zniknie.

Wygaszacz ekranu pozwala zapobiedz wypalaniu.

Zawsze U ywaj wygaszacza ekranu.

1. Naci nij przycisk "Screensaver" by otworzy
okno "Screensaver Settings".

Control Panel

E 2. Wprowad ilo minut po ktérych wygaszacz

1
zostajw uruchomiony.
N Dotknij pola tekstwego by to zrobi . Mo esz
3 wprowadza warto ciod 5 do 360 minut.
v ) Whprowadzenie "0" wy cza wygaszacz

ekranu.

3. Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".

Ustawienie sygna 6w akustycznych

1. U yjprzycisku "Volume Setting" by otworzy
okno "Sound Settings".

2. Zaznacz pole wyboru "Sound ON". Kiedy
pole "Sound ON" jest wybrane, sygna
d wi kowy b dzie wyst powa w
nast puj cych przypadkach:
- Dotkni cie ekranu dotykowego.
- Wy wietlona wiadomo

3. Zamknij okno i zapisz wprowadzone zmiany
za pomoc "OK".
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Przygotowanie HMI do projektu

6.1 Przegl d

Faza konfiguracji

Projekt — obraz dzia aj cych proceséw roboczych — jest wykonywany podczas konfiguracji
aby zwizualizowa zautomatyzowany proces roboczy. Wy wietlacze proceséw w projekcie
zawieraj wy wietlacze warto ci oraz wiadomo ci, ktére dostarczaj informacji o statusie
procesu. Po fazie konfiguracji nast puje faza kontroli procesu.

Faza kontroli procesu

Je li projekt ma by u yty w sterowaniu procesem, musi zosta przes any na urz dzenie HMI.
Kolejnym warunkiem sterowania procesem jest, by urz dzenie HMI by o po czone online do
sterownika. Bie ce procesy robocze — dzia aj ce i obserwowane —mog by obiektem
sterowania procesem.

Przesy anie projektu do urz dzenia HMI
Mo esz przesa projekt do urz dzenia HMI w nast puj cy sposoéb:
* Przesy z PC konfiguracyjnego
* Przywrocenie z PC u ywaj ¢ ProSave

W tym przypadku, projekt jest przesy any z PC do urz dzenia HMI.
Oprogramowanie konfiguracyjne nie musi by zainstalowane na tym PC.

Pocz tkowe oraz ponowne przygotowanie HMI do projektu
Pocz tkowe oraz powtdrne przygotowanie ro ni si od siebie w nast puj co:
e Gdy urz dzenie HMI jest przygotwywane pocz tkowo, nie ma na nim adnego projektu.
Urz dzenie HMI jest rownie w tym stanie po aktualizacji systemu operacyjnego.

e Podczas ponownego przygotowywania, projekt na urz dzeniu HMI zostaje zast piony.

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
Instrukcja u ytkowa, 01/2009, A5SE02421799-01 65



Przygotowanie HMI do projektu

6.2 Tryby pracy

6.2 Tryby pracy

Tryby pracy
Urz dzenie HMI mo e znajdowa si w jednym z nast puj cych trybow:
« Offline
e Online
e Transfer

Tryby "Offline mode" oraz "Online mode" mog by ustawione na PC konfiguracyjnym jak
i na urz dzeniu HMI. By ustawi te tryby na urz dzeniu HMI, u yj odpowiednich elementow
u ytkowych w projekcie.

Zmiana trybu pracy

In ynier konfiguruj cy musi skonfigurowa odpowiedni element u ytkowy by umo liwi
zmian trybu u ytkowego na urz dzeniu HMI w czasie dzia ania.

Dalsze informacje mog by dost pne w dokumentacji ruchowej.

Tryb pracy "Offline"

W tym trybie, nie ma komunikacji pomi dzy urz dzeniem HMI, a PLC. Urz dzenie HMI mo e
byc jednak u ytkowane, nie mo e tylko wymienia danych z PLC.

Tryb pracy "Online"

W tym trybie, urz dzenie HMI oraz PLC komunikuj si . Mo esz sterowa instalacj na
urz dzeniu HMI zgodnie z konfiguracj systemow .

Tryb "Transfer"

W tym trybie mo esz na przyk ad przes a projekt z PC konfiguracyjnygo do urz dzenia HMI
lub skopiowa i przywr6ci dane z urz dzenia HMI.

Dost pne s nast puj ce opcje ustawienia trybu "Transfer" na urz dzeniu HMI:
» Podczas uruchamiania urz dzenia HMI

Uruchom tryb "Transfer" r cznie w Programie aduj cym urz dzenia HMI.
e Podczas dziaaj cych operacji

Uruchom tryb "Transfer" r cznie w projekcie u ywaj ¢ odpowiedniej kontrolki operatora.
Urz dzenie HMI prze cza sie w tryb "Transfer", kiedy ustawiony jest tryb automatyczny
oraz przesy zosta zainicjowany na PC konfiguracyjnym.
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6.3 Opcje przesy u danych

6.3 Opcje przesy u danych

Przegl d

Nast puj ca tabela pokazuje opcje dla przesy u danych pomi dzy urz dzeniem
HMI, a PC konfiguracyjnym.

Typ Kana danych Panele Basic DP Panele Basic PN
Kopia / przywracanie danych, Szeregowy > Tak )
Aktualizacja systemu, MPI/PROFIBUS DP Tak -

Przesy projektu PROFINET - Tak
Aktualizacja systemu Szeregowy > Tak -
operacyjnego z "Reset to MPI/PROFIBUS DP N N

factory settings"

PROFINET - Tak

') Dotyczy operacji z przewodem PC/PPI 6ES7 901-3CB30-0XA0 lub przewodem
USB/PPI 6ES7 901-3DB30-0XA0.

6.4 Przesy

6.4.1 Przegl d

Przes anie projektu wykonawczego z PC konfiguracyjnego na urz dzenie HMI.
Mo esz uruchomi na urz dzeniu HMI tryb "Transfer" automatycznie lub r cznie.

Przesy ane dane s zapisywane bezpo rednio do wewn trznej pami ci flash urz dzenia HMI.
Nastaw parametry odpowiednich kana 6w danych przed rozpocz ciem przesy u.

6.4.2 Przesy r czny

Wprowadzenie
Mo eszr cznie prze czy urz dzenie HMI w tryb "Transfer" w nast puj cy sposoéb:
» W czasie pracy, u ywaj ¢ odpowiedniej kontrolki operatora.

» W Programie aduj cym na urz dzeniu HMI.

Wymagania
* Projekt *.hmi jest otwarty w WinCC flexible.
e Urz dzenie HMI jest pod czone do PC konfiguracyjnego.
e Kana danych zosta skonfigurowany na urz dzeniu HMI

e Urz dzenie HMI jest w trybie "Transfer".
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6.4 Przesy

Procedura

Wynik

Post puj jak opisano:

1. Na PC konfiguracyjnym, wybierz polecenie "Transfer settings" z menu "Project >
Transfer" w WinCC flexible.

Otworzy si okno "Select devices for transfer".

2. Wybierz urz dzenie HMI w lewym obszarze okna.

3. Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC konfiguracyjnym.
Ustaw parametry po czenia.

4. Ustaw parametry przesy u w prawym obszarze okna.

5. Rozpocznij przesy w WiInCC flexible przez wybranie "Transfer".

PC konfiguruj ce sprawdza po czenie z urz dzeniem HMI. Projekt jest przesy any
do urz dzenia HMI. Je li po czenie jest niedost pne lub zosta o zak 6cone, na PC
konfiguruj cym pojawia si wiadomo ob dzie.

Projekt jest dost pny na urz dzeniu HMI po udanym przesyle. Przes any projekt
jest uruchamiany natychmiastowo.

6.4.3 Przesy automatyczny

Wprowadzenie

68

Je li przesy automatyczny zosta aktywowany, urz dzenie HMI automatycznie prze cza si
w tryb "Transfer" w chwili, gdy na pod czonym PC konfiguracyjnym uruchomimy przesy .

Nota

Przy automatycznym przesyle, urz dzenie HMI prze cza si w tryb "Transfer" tylko je li na
urz dzeniu HMI jest uruchomiony projekt.

Przesy automatyczny jest szczego6lnie przydatny w fazie testowania nowego projektu,
poniewa przesy mo e by zako czony bez ingerowania w urz dzenie HMI.

UWAGA

Je lina urz dzeniu HMI aktywowany jest przesy automatyczny, oraz przesy zosta
zainicjowany na PC konfiguracyjnym, projekt, ktory jest aktualnie otwarty zostaje
natychmiast zatrzymany. Urz dzenie HMI prze czasi wtedy w tryb "Transfer".

Po fazie przygotowania, deaktywuj przesy automatyczny tak, aby urz dzenie HMI nie

zosta o prze czone w tryb przesy u. Tryb przesy u mo e wywo a niezamierzone
dzia anie instalaciji.

Mo esz ustanowi has o w Panelu Sterowania by zastrzec dost p do ustawie przesy u,
pozwoli to unikn  nieautoryzowanych modyfikaciji.
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6.4 Przesy
Wymagania
« Projekt *.hmi jest otwarty w WinCC flexible.
e Urz dzenie HMI jest pod czone do PC konfiguracyjnego.
« Kana danych zosta skonfigurowany na urz dzeniu HMI
« Dla przesy u aktywowany jest automatyczny przesy w kanale danych
e Naurz dzeniu HMI jest uruchomiony projekt.
Procedura
Post puj jak opisano:
1. Na PC konfiguracyjnym, wybierz polecenie "Transfer settings" z menu "Project >
Transfer" w WinCC flexible.
Otworzy si okno "Select devices for transfer".
6. Wybierz urz dzenie HMI w lewym obszarze okna.
7. Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC konfiguracyjnym.
Ustaw parametry po czenia.
8. Ustaw parametry przesy u w prawym obszarze okna.
9. Rozpocznij przesy w WiInCC flexible przez wybranie "Transfer".
PC konfiguruj ce sprawdza po czenie z urz dzeniem HMI. Urz dzenie HMI wy cza
bie cy projekt i automatycznie przechodzi do trybu "Transfer". Projekt jest przesy any do
urz dzenia HMI. Je li po czenie jest niedost pne lub zosta o zak 6cone, na PC
konfiguruj cym pojawia si wiadomo ob dzie.
Wynik

Projekt jest dost pny na urz dzeniu HMI po udanycm przesyle. Przes any projekt jest
uruchamiany natychmiastowo.

6.4.4 Testowanie projektu

Wprowadzenie
Istniej nast puj ce mo liwo citestowania projektu:
e Testowanie projektu na PC konfiguracyjnym

Mo esz testowa projekt na PC konfiguracyjnym, u ywaj c symulatora. Po dok adniejsze
informacje, odnie si do podr cznika u ytkownika "WinCC flexible" oraz do pomocy online.

« Testowanie offline projektu na urz dzeniu HMI

Testowanie offline oznacza, e podczas testu nie isthieje komunikacja mi dzy urz dzeniem
HMI, a PLC.

« Testowanie online projektu na urz dzeniu HMI

Testowanie online oznacza, e podczas testu urz dzenie HMI oraz PLC komunikuja si  ze
sob .
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6.4 Przesy

Wykonaj kolejnio testy, rozpoczynaj c od "Offline test", nast pnie "Online test".

Nota

Powiniene zawsze testowa projekt na urz dzeniu HMI na ktérym projekt b dzie u ywany.

Sprawd :

1. Poprawn kompozycj ekranéw.

2. Nawigacj ekranow .

3. Obiekty wej ciowe.

4. Wprowad warto ci zmiennych.

Przeprowadzenie testu zwi ksza pewno , e projektb dzie dziaa bezb dnie na

urz dzeniu HMI.

Wymagania testowania offline
» Projekt zosta przes any do urz dzenia HMI.

e Urz dzenie HMI jest w trybie "Offline".

Procedura

W trybie "Offline", mo esz testowa indywidualne funkcje projektu na urz dzeniu HMI, bez
wp ywaj cedo na nhie PLC. Zmienne PLC nie s aktualizowane.

Przetestuj kontrolki operatora oraz wizualizacje projektu tak dalece jak to tylko
mo liwe bez pod czania do PLC.

Wymagania testowania online
« Projekt zosta przes any do urz dzenia HMI.

e Urz dzenie HMI jest w trybie "Online".

Procedura

W trybie "Online", mo esz testowa indywidualne funkcje projektu na urz dzeniu HMI, wraz
zwp ywaj cym na nie PLC. Zmienne PLC s w tym przypadku aktualizowane.

Masz mo liwo przetestowania wszystkich funkcji zale nych od komunikacji, na przyk ad

alarmow itp. Przetestuj kontrolki operatora oraz kontrolki widoku w projekcie.
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6.5 Kopia bezpiecze stwa i przywracanie danych

6.5 Kopia bezpiecze stwai przywracanie danych

6.5.1 Przegl d

Kopia bezpiecze stwai przywracanie danych

Mo esz skopiowa iprzywréci nast puj ce dane z wewn trznej pami ciflash
urz dzenia HMIl do i z PC.

» Projekt oraz obraz urz dzenia HMI

» Lista hase

* Dane receptury

U yj jednego z poni szych narz dzi, eby dokona kopiowania bezpiecze stwa oraz
przywracania.

*  WIinCC flexible

¢ ProSave

Informacje ogélne

Zobacz réwnie

NOTA

Awaria zasilania

Je li operacja ca kowitego przywracania zostanie zak 6cona przez awari zasilania, system
operacyjny na urz dzeniu HMI mo e by usuni ty. W takim wypadku nale y przywrdci
ustawienia fabryczne na urz dzeniu HMI.

Konflikt kompatybilno ci

Je linaurz dzeniu HMI pojawi si wiadomo ostrzegaj ca przed konfliktem
kompatybilno ci, podczas operacji przywracania, system operacyjny musi by
zaktualizowany.

Nota

Przesy danych mo e potrwa kilka minut, w zale no ci od obj to ci danych oraz pr dko ci
przesy u. Zwré6 uwag nhawy wietlanie statusu. Nie zak 6caj przesy u danych.

Opcje przesy u danych (Strona 67)
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6.5 Kopia bezpiecze stwa i przywracanie danych

6.5.2 Kopia bezpiecze stwai przywracanie danych za pomoc WinCC flexible

Wymagania

» aden projekt nie jest otwarty na PC konfiguracyjnym w WinCC flexible.
» Urz dzenie HMI jest pod czone do PC konfiguracyjnego.

» Kana danych na urz dzeniu HMI zosta skonfigurowany.

Procedura — Kopia bezpiecze stwa
Post puj jak opisano:

1. Na PC konfiguracyjnym, wybierz polecenie "Communication settings" z menu
"Projekt > Transfer" w WinCC flexible.

Otworzy si okno "Communication Settings".

Wybierz typ urz dzenia HMI.

w

Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC konfiguracyjnym.
Ustaw parametry po czenia.

Zamknij okno za pomoc "OK".

Wybierz polecenie "Backup" w menu "Project > Transfer" w WinCC flexible.
Otworzy si okno "Backup settings".

Wybierz dane, ktére maj by zapisane.

Wybierz folder docelowy oraz nazw pliku kopii bezpiecze stwa "*.psb".

© © N o g &

Prze cz w tryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
generowania kopii bezpiecze stwa urz dzenie HMI automatycznie prze czysi w
tryb "Transfer".

10. Uruchom tworzenie kopii bezpiecze stwa w WInCC flexible przyciskiem "OK".
11. Post puj zgodnie z instrukcjami w WinCC flexible.

Otwiera si  kontrolka statusu wskazuj ca postep operaciji.

Wynik
System wysy a wiadomo , kiedy kopia bezpiecze stwa jest uko czona.

Odpowiednie dane s zapisane na PC konfiguracyjnym.
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6.5 Kopia bezpiecze stwa i przywracanie danych

Procedura — przywracanie

Wynik

Post puj wg procedury:

1

o oA W N

Na PC konfiguracyjnym, wybierz polecenie "Communication settings" w menu
"Project > Transfer" w WinCC flexible.

Otworzy si okno "Communication settings".

Wybierz typ urz dzenia HMI.

Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC konfoguracyjnym.
Ustaw parametry po czenia.

Zamknij okno przyciskiem "OK".

Wybierz polecenie "Restore" w menu "Project > Transfer" w WinCC flexible.
Otworzy si  okno "Restore Settings".

Wybierz plik kopi zapasowej "*.psb", ktéry chcesz przywréci , z pola "Open".

Mo esz zobaczy dla ktérego urz dzenia HMI kopia zosta a utworzona oraz jakie dane
zawiera plik kopii zapasowej.

Prze cz wtryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
przywracania, urz dzenie HMI automatycznie prze czy si w tryb "Transfer".

Rozpocznij operacj przywracania flexible za pomoc "OK" na PC konfiguracyjnym.
Post puj zgodnie z instrukcjami w WinCC flexible.

Otwiera si  kontrolka statusu wskazuj ca postep operaciji.

Kiedy przywracanie zostanie zako czone, kopia zapasowa danych z PC znajduje si na
urz dzeniu HMIL.
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6.5 Kopia bezpiecze stwa i przywracanie danych

6.5.3

Wymagania

Kopia bezpiecze stwai przywracanie danych za pomoc ProSave

Urz dzenie HMI jest pod czone do PC na ktorym zainstalowany jest ProSave.

Kana danych urz dzenia HMI jest skonfigurowany.

Procedura — Kopia bezpiecze stwa
Post puj jak opisano:

Wynik

74

1
2.
3.

Uruchom menu Start systemu Windows a nast pnie ProSave na PC.
Wyhirz typ urz dzenia HMI w zak adce "General".

Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC.

Ustaw parametry po czenia.

Wybierz dane, ktére maj by skopiowane, na zak asce "Backup".

"Complete backup" wykonuje kopi bezpiecze stwa danych konfiguraciji, receptur oraz
obrazu urz dzenia HMI w pliku formatu PSB.

- "Recipes" wykonuje kopi bezpiecze stwa rekordéw danych receptur urz dzenia HMI
w formacie PSB.

- "Recipes (format CSV)" zapisuje kopi bezpiecze stwa rekordéw danych receptury
urz dzenia HMI w postaci pliku tekstowego w formacie CSV. rednik jest u ywany
jako separator kolumn.

- "User management" wykonuje kopi bezpiecze stwa danych u ytkowanika urz dzenia
HMI w formacie PSB.

Wybierz folder oraz nazw pliku dla pliku kopii bezpiecze stwa "*.psb".
Kiedy generujesz kopi bezpiecze stwa receptur w formacie CSV, wybierasz tylko folder.
Plik CSV jest generowany w folderze dla ka dej receptury.

Prze cz wtryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
generowania kopii bezpiecze stwa urz dzenie HMI automatycznie prze czysi w
tryb "Transfer".

Rozpocznij operacj w ProSave za pomoc "Start Backup".
Post puj zgodnie z instrukcjami w ProSave.

Pasek post pu wskazuje post p operaciji.

System wysy a wiadomo , kiedy kopia bezpiecze stwa jest gotowa.

Kopia danych jest teraz dost pna na PC.
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6.5 Kopie bezpiecze stwa i przywracanie danych

Procedura — przywracanie danych
Post puj wg procedury:

1

g M w D

Uruchom menu Start systemu Windows, a nast pnie ProSave na PC.

Wybierz typ urz dzenia HMI w zak adce "General".

Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC.

Ustaw parametry po czenia.

Wybierz plik kopii "*.psb", z ktérej chcesz przywréci dane, z zak adki "Restore".

Mo esz zobaczy urz dzenie HMI dla ktérego zosta a utworzona kopia zapasowa oraz
jekie dane ona zawiera.

Wybierz jeden lub kilka plikow CSV z folderu rdd owego by przywrdci receptury z plikow
CSV.

Prze cz wtryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
przywracania urz dzenie HMI automatycznie prze czysi w tryb "Transfer".

7. Uruchom przywracanie w ProSave na PC za pomoc "Start Restore".

8. Post puj zgodnie z instrukcjami w ProSave.

Wynik

Pasek post pu wskazuje post p operaciji.

Kiedy przywracanie zostanie zako czone, kopia zapasowa danych z PC znajduje si na
urz dzeniu HMIL.
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6.6 Aktualizacja OS — Panel Basic DP

6.6.1 Przegl d

Aktualizacja systemu operacyjnego

Podczas przesy u projektu na urz dzenie HMI mo e powsta konflikt kompatybilno ci.
Spowodowane jest to r6 nymi wersjami oprogramowania u ytego oraz obrazu urz dzenia
HMI na nim dost pnego. Je liwersje s rd ne, przesy zostaje anulowany. Na PC
konfiguracyjnym zostaje wy wietlona wiadomo wskazuj ca na konflikt kompatybilno ci.

Istniej dwie metody by wyréwna wersje:

« Aktualizowa obraz urz dzenia HMI, je li projekt zosta stworzony przez najnowsz wersj
oprogramowania konfiguracyjnego.

e Przesa odpowiedni wersj obrazu urz dzenia HMI je li nie chcesz adaptowa projektu
dla urz dzenia HMI do najnowszej dost pnej wersji oprogramowania dla projektu.

NOTA

Utrata danych

Wszystkie dane na urz dzeniu HMI, takie jak projekt i licencje zostan usuni te, kiedy
aktualizujesz system operacyjny.

Nota
Kalibracja ekranu dotykowego

Po aktualizacji, konieczna b dzie ponowna kalibracja ekranu dotykowego.
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6.6.2 Przywracanie ustawie fabrycznych
W ProSave lub WinCC flexible, mo na wykona aktualizacj systemu operacyjnego z lub bez
przywracania ustawie fabrycznych.

Zobacz rownie

Aktualizacja systemu operacyjnego bez przywracania ustawie fabrycznych

Najpierw, prze cz urz dzenie HMI w tryb "Transfer" lub u yj funkcji automatycznego
przesy u, je li projekt jest aktywny. Nast pnie uruchom aktualizacj systemu operacyjnego

w ProSave lub WinCC flexible.
Aktualizacja systemu operacyjnego z przywréceniem ustawie fabrycznych

NOTA

Kanay danych
Kiedy przywracasz ustawienia fabryczne, wszystkie parametry kana u danych zostaj
zresetowane. Przesy b dzie mo liwy po ponownej konfiguracji kana 6w danych.

Nota

Musisz wykona aktualizacj systemu operacyjnego z przywréceniem ustawie
fabrycznych, je liurz dzenie HMI nie posiada systemu operacyjnego lub, gdy system

operacyjny urz dzenia HMI jest uszkodzony.

Najpierw, uruchom aktualizacj systemu operacyjnego w ProSave lub WinCC flexible oraz
wy cziw cz zasilanie urz dzenia HMI, kiedy zostaniesz o to poproszony.

Opcje przesy u danych (Strona 67)

6.6.3 Aktualizacja systemu operacyjnego u ywaj ¢ WinCC flexible

Wymagania

Urz dzenia HMI jest pod czone do PC konfiguracyjnego.

e aden projekt nie jest otwarty w WinCC flexible.

« Dotyczy aktualizacji bez przywracania ustawie fabrycznych:
Kana danych jest skonfigurowany na urz dzeniu HMI.
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Procedura

Post puj jak opisano:

1. Dotyczy aktualizacji systemu operacyjnego z przywracaniem ustawie fabrycznych:
Wy cz zasilanie na urz dzeniu HMI.

2. Na PC konfiguracyjnym, wybierz polecenie "Communication settings" w menu
"Project > Transfer" w WinCC flexible.
Otwiera si  okno "Communication Settings".
Wybierz typ urz dzenia HMI.
Wybierz typ po czenia mi dzy urz dzeniem HMI, a PC konfiguracyjnym, nast pnie
ustaw parametry po czenia.

5. Zamknij okno za pomoc "OK".
Wybierz polecenie "OS Update" z menu "Project > Transfer" w WinCC flexible.
Wybierz, czy aktualizowa system operacyjny z czy bez przywracania ustawie
fabrycznych zaznaczaj ¢ odpowiednio pole wyboru "Reset to factory settings".

8. Woybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".
Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible
DVD.
Obszar wyj ciowy dostarcza informacji o wersji poprawnie otwartego pliku obrazu
urz dzenia HMI.

9. Dotyczy aktualizacji bez przywracania ustawie fabrycznych:
Prze cz w tryb "Transfer" na urz dzeniu HMI.
Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
aktualizacji urz dzenie HMI automatycznie prze czy si w tryb "Transfer".

10. W WiInCC flexible, wybierz "Update OS" na PC konfiguracyjnym by rozpocz
aktualizacj systemu operacyjnego.

11. Dotyczy aktualizacji z przywracaniem ustawie fabrycznych:
W cz zasilanie urz dzenia HMI.

12. Post puj zgodnie z instrukcjami WinCC flexible.
Pasek post pu pokazuje post p aktualizacji systemu operacyjnego.

Wynik

Gdy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu.
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6.6.4

Wymagania

Procedura
1
4.
7.
8.
9.
10.
11.

Wynik

6.6 Aktualizacja OS — Panel Basic DP

Aktualizacja systemu operacyjnego u ywaj c ProSave

Urz dzenie HMI jest pod czone do PC na ktérym zainstalowany jest ProSave
Dotyczy aktualizacji systemu operacyjnego bez przywracania ustawie fabrycznych:

Kana danych urz dzenia HMI jest skonfigurowany.

Post puj jak opisano:

Dotyczy aktualizacji systemu operacyjnego z przywracaniem ustawie fabrycznych:
Wy cz zasilanie na urz dzeniu HMI.

Uruchom menu Start systemu Windows, a nast pnie ProSave na PC.

Wybirz typ urz dzenia HMI w zak adce "General".

Wybierz typ po czenia pomi dzy urz dzeniem HMI oraz PC, nast pnie ustaw
parametry po czenia.

Wyhierz zak adk "OS Update".

Wyhierz, czy aktualizowa system operacyjny z czy bez przywracania ustawie
fabrycznych zaznaczaj c lub nie- pole wyboru "Reset to factory settings".

Wybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".

Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible
DVD.

Obszar wyj ciowy dostarcza informacji o wersji poprawnie otwartego pliku obrazu
urz dzenia HMI.

Dotyczy aktualizacji bez przywracania ustawie fabrycznych:
Prze cz w tryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po
zainicjowaniu aktualizacji urz dzenie HMI automatycznie prze czy si w tryb
"Transfer".

Wybierz "Update OS" na PC by uruchomi aktualizacj systemu operacyjnego.
Dotyczy aktualizacji z przywracaniem ustawie fabrycznych:

W cz zasilanie urz dzenia HMI.

Post puj zgodnie z instrukcjami w ProSave.

Pasek post pu wskazuje post p aktualizacji systemu operacyjnego.

Gdy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu.
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6.7 Aktualizacja OS — Panel Basic PN

6.7.1 Przegl d

Aktualizacja systemu operacyjnego

Podczas przesy u projektu na urz dzenie HMI mo e powsta konflikt kompatybilno ci.
Spowodowane jest to r6 nymi wersjami oprogramowania u ytego oraz obrazu urz dzenia
HMI na nim dost pnego. Je li wersje s rd ne, przesy zostaje anulowany. Na PC
konfiguracyjnym zostaje wy wietlona wiadomo wskazuj ca na konflikt kompatybilno ci.

Istniej dwie metody by wyréwna wersje:

« Aktualizowa obraz urz dzenia HMI, je li projekt zosta stworzony przez najnowsz wersj
oprogramowania konfiguracyjnego.

e Przesa odpowiedni wersj obrazu urz dzenia HMI je li nie chcesz adaptowa projektu
dla urz dzenia HMI do najnowszej dost pnej wersji oprogramowania dla projektu.

UWAGA

Utrata danych

Wszystkie dane na urz dzeniu HMI, takie jak projekt i licencje zostan usuni te, kiedy
aktualizujesz system operacyjny.

Nota
Kalibracja ekranu dotykowego

Po aktualizacji, konieczna b dzie ponowna kalibracja ekranu dotykowego.
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6.7 Aktualizacja OS — Panel Basic PN

6.7.2 Przywracanie ustawie fabrycznych
W ProSave lub WinCC flexible, mo na wykona aktualizacj systemu operacyjnego z lub bez
przywracania ustawie fabrycznych.

Zobacz rownie

Aktualizacja systemu operacyjnego bez przywracania ustawie fabrycznych

Najpierw, prze cz urz dzenie HMI w tryb "Transfer" lub u yj funkcji automatycznego
przesy u, je li projekt jest aktywny. Nast pnie uruchom aktualizacj systemu operacyjnego

w ProSave lub WinCC flexible.
Aktualizacja systemu operacyjnego z przywréceniem ustawie fabrycznych

NOTA

Kanay danych
Kiedy przywracasz ustawienia fabryczne, wszystkie parametry kana u danych zostaj

zresetowane. Przesy b dzie mo liwy po ponownej konfiguracji kana 6w danych.

Nota

Musisz wykona aktualizacj systemu operacyjnego z przywréceniem ustawie
fabrycznych, je liurz dzenie HMI nie posiada systemu operacyjnego lub, gdy system

operacyjny urz dzenia HMI jest uszkodzony.

Najpierw, uruchom aktualizacj systemu operacyjnego w ProSave lub WinCC flexible oraz
Wy cziponownie w cz zasilanie urz dzenia HMI, gdy b dzie to sygnalizowane.

Opcje przesy u danych (Strona 67)
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6.7.3 Aktualizacja systemu operacyjnego u ywaj ¢ WinCC flexible

Wymagania
e aden projekt nie jest otwarty na PC konfiguracyjnym w WinCC flexible.
e Urz dzenie HMI jest pod czone do PC konfiguracyjnego.

« Kana danych zosta skonfigurowany na urz dzeniu HMI.

Procedura
Post puj jak opisano:

1. Na PC konfiguracyjnym, wybierz polecenie "Communication settings" z menu
"Projekt > Transfer" w WinCC flexible.

Otworzy si okno "Communication Settings".

Wybierz typ urz dzenia HMI.

Wybierz typ po czenia pomi dzy urz dzeniem HMI, a PC konfiguracyjnym.
Ustaw parametry po czenia.

Zamknij okno za pomoc "OK".

W WinCC flexible, wybierz polecenie "OS Update" z menu "Projekt > Transfer".

N o a b~ w D

Wybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".

Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible DVD.

Obszar wyj ciowy dostarcza informacji o wersji poprawnie otwartego pliku obrazu
urz dzenia HMI.

8. Prze cz wtryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po zainicjowaniu
aktualizacji urz dzenie HMI automatycznie prze czy si w tryb "Transfer".

9. W WinCC flexible, wybierz "Update OS" na PC konfiguracyjnym by uruchomi
aktualizacj systemu operacyjnego.

10. Post puj zgodnie z instrukcjami w WinCC flexible.

Pasek post pu wskazuje post p aktuaizacji systemu operacyjnego.

Wynik
Kiedy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu.
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6.7.4

Wymagania

Procedura
1
2.
3.
4.
5.
6.
7.
8.

Wynik

6.7 Aktualizacja OS — Panel Basic PN

Aktualizacja systemu operacyjnego u ywaj c ProSave

Urz dzenie HMI jest pod czone do PC na ktorym zainstalowany jest ProSave.

Kana danych jest skonfigurowany na urz dzeniu HMI.

Post puj jak opisano:

Uruchom menu Start systemu Windows, a nast pnie ProSave na PC.
Wyhierz typ urz dzenia HMI w zak adce "General".

Wybierz typ po czenia pomi dzy urz dzeniem HMI a PC.

Ustaw parametry po czenia.

Wybierz zak adk "OS Update".

Wybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".

Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible
CD.

Obszar wyj ciowy dostarcza informacji 0 wersji poprawnie otwartego pliku
obrazu urz dzenia HMI.

Prze cz wtryb "Transfer" na urz dzeniu HMI.

Je li aktywowa e automatyczny tryb przesy u na urz dzeniu HMI, po
zainicjowaniu aktualizacji urz dzenie HMI automatycznie prze czysi w tryb
"Transfer", gdy aktualizacja zostanie zainicjowana.

Wyhierz "Update OS" na PC by uruchomic aktualizacj systemu operacyjnego.

9. Post puj zgodnie z instrukcjami w ProSave.

Pasek post pu wskazuje post p aktualizacji systemu operacyjnego.

Kiedy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu.
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6.7.5 Przywracanie ustawie fabrycznych z WinCC flexible

Wymagania

aden projekt nie jest otwarty na PC konfiguracyjnym w WinCC flexible.
Urz dzenie HMI jest pod czone do PC konfiguracyjnego za pomoc przewodu Ethernet.
Posiadasz adres MAC swojego urz dzenia HMI interfejsu Ethernet.
- Adres MAC jest wy wietlany krétko, kiedy urz dzenie HMI jest w czane.

- Adres MAC jest wy wietlany w oknie "Profinet" w zak adce "Device" w Panelu
Sterowania.

Procedura ustwiania interfejsu PC

1
2.
3.

Wybierz "Start > Control Panel > Set PG / PC interface" na PC konfiguracyjnym.
Wybierz "S7TONLINE (STEP7) -> TCP / IP" z obszaru "Application access point".

Wybierz interfejs, ktdrym pod czone jest urz dzenie HMI z obszaru "Interface
parameterization used".

Potwierd wprowadzone zmiany.

Procedura przywracania ustawie fabrycznych

Post puj jak opisano:

1

Na PC konfiguracyjnym, wybierz polecenie "Communication settings" w menu
"Project > Transfer" w WinCC flexible.

Otworzy si okno "Communication Settings".

Wybierz typ urz dzenia HMI z zak adki "General" oraz wybierz "Ethernet" z obszaru
"Connection".

Wprowad adres IP.

Nota
Mo liwy konflikt adreséw z niepoprawnym adresem IP
Nie u ywaj dynamicznej konfiguracji IP dla "Reset factory settings".

Okre | unikalny adres IP podsieci, w ktérej komputer konfiguracyjny jest umieszczony.
Na czas procesu aktualizacji, urz dzenie HMI jest automatycznie przypisywane do
okre lonego adresu w ProSave.

Je liurz dzenie HMI byoju u ywane z WinCC flexible lub ProSave mo esz wykorzysta
istniej cy adres IP dla "Reset factory settings".

4. Potwierd wprowadzone zmiany.
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5. Wybierz polecenie "OS Update" z menu "Project > Transfer" w WinCC flexible.
Wybierz pole wyboru "Reset factory settings".
Otwiera sie okno, w ktérym mo esz wprowadzi adres MAC.
Wprowad adres MAC urz dzenia HMI w okno tekstowe.

8. Woybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".

Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible DVD.

Obszar wyj ciowy dostarcza informacji o wersji poprawnie otwartego pliku obrazu
urz dzenia HMIL.

9. W WinCC flexible, wybierz "Update OS" na PC konfiguracyjnym by uruchomi
aktualizacj systemu operacyjnego.

10. Post puj zgodnie z instrukcjami w WinCC flexible na PC konfiguracyjnym.

Pasek postepu wskazuje bie cy post p aktualizacji systemu operacyjnego.

Wynik
Kiedy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu. Ustawienia fabryczne zosta y przywrécone.

Nota

Je linie mo eszwywoa Panelu Sterowania na urz dzeniu HMI, gdy system operacyjny
jest uszkodzony, wy cz urz dzenie HMI. Nast pnie przywrd ustawienia fabryczne i zresetu;j
urz dzenie HMI.

Je liurz dzenie HMI nie uruchomi si , wy cz je i uruchom ponownie.

Nota
Kalibrowanie ekranu dotykowego
Po przywracaniu, konieczne b dzie ponowne skalibrowanie ekranu dotykowego.
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6.7.6 Przywracanie ustawie fabrycznych z ProSave

Wymagania
e Urz dzenie HMI jest pod czone przez Ethernet do PC gdzie zainstalowany jest ProSave.

» Posiadasz adres MAC swojego urz dzenia HMI interfejsu Ethernet.
- Adres MAC jest wy wietlany krétko, kiedy urz dzenie HMI jest w czane.

- Adres MAC jest wy wietlany w oknie "Profinet" w zak adce "Device" w Panelu
Sterowania.

Procedura ustawiania interfejsu na PC
1. Woybierz "Start > Control Panel > Set PG / PC interface" na komputerze konfiguracyjnym.

2. Wybierz "S7TONLINE (STEP7) -> TCP / IP" z obszaru "Application access point".

3. Wybierz interfejs, ktérym pod czone jest urz dzenie HMI, z obszaru "Interface
parameterization used".

4. Potwierd wprowadzone zmiany.

Procedura przywracania ustawie fabrycznych
Post puj jak opisano:

1. Uruchom menu Start systemu Windows, a nast pnie ProSave na PC.

=, SIMATIC P roSawe

File Larnguage  Help

i Backup] Fiestunﬂ Dptiuns1 05 Update]

Device type
| [Operatior Panel] _"_J
Connection
| Ethermet j

-Connechion pararmeters

o |P address 7 Camputer name

TeE 188 . T D

Completed Ethernet

2. Wybierz typ urz dzenia w zak adce "General" oraz wybierz "Ethernet" z obszaru
Connection (Po czenia).
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Wynik

6.7 Aktualizacja OS — Panel Basic PN

. Wprowad adres IP.

Nota
Mo liwy konflikt adreséw z niepoprawnym adresem IP
Nie u ywaj dynamicznej konfiguracji IP dla "Reset factory settings".

Okre | unikalny adres IP podsieci, w ktérej komputer konfiguracyjny jest umieszczony.
Na czas procesu aktualizacji, urz dzenie HMI jest automatycznie przypisywane do
okre lonego adresu w ProSave.

Je liurz dzenie HMI by o ju u ywane z WinCC flexible lub ProSave mo esz wykorzysta
istniej cy adres IP dla "Reset factory settings".

4. Zmie nazakadk "OS Update".

5. Zaznacz pole wyboru "Reset factory settings".

Otworzy si  okno w ktérym b dzie mo na wprowadzi adres MAC.

6. Wprowad adres MAC w okno tekstowe.

. Wybierz plik obrazu urz dzenia HMI o rozszerzeniu "*.img" w "Image path".

Pliki obrazu urz dzenia HMI s dost pne w folderze instalacyjnym WinCC
flexible "WinCC flexible Images" lub na p ycie instalacyjnej WinCC flexible DVD.

Obszar wyj ciowy dostarcza informacji o wersji poprawnie otwartego pliku obrazu
urz dzenia HMIL.

8. Wybierz "Update OS" na PC by rozpocz proces "Reset to factory settings".

9. Post puj zgodnie z instrukcjami w ProSave.

Pasek post pu wskazuje post p aktualizacji systemu operacyjnego.

Gdy aktualizacja systemu zostanie zako czona, wy wietlana jest wiadomo

Urz dzenie HMI nie zawiera ju danych projektu. Ustawienia fabryczne zosta y przywrdcone.

Nota

Je linie mo eszwywoa Panelu Sterowania na urz dzeniu HMI, gdy system operacyjny
jest uszkodzony, wy cz urz dzenie HMI. Nast pnie przywré ustawienia fabryczne i zresetuj
urz dzenie HMI.

Je liurz dzenie HMI nie uruchomi si , wy cz je i uruchom ponownie.

Nota
Kalibrowanie ekranu dotykowego

Po przywracaniu, konieczne b dzie ponowne skalibrowanie ekranu dotykowego.
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6.7 Aktualizacja OS — Panel Basic PN
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7.1 Konserwacja i serwis

Wprowadzenie
Urz dzenie HMI jest zaprojektowane do dzia ania bezobs ugowego. Jednak e ekran dotykowy
oraz membrana klawiatury powinny by czyszczone regularnie.

Wymagania
U yj ciereczki do czyszczenia nawil onej rodkiem czyszcz cym by wyczy ci sprz t.
U ywaj tylko wody z myd em lub pianki do czyszczenia ekranow.
NOTA
Niezamierzona odpowied
Gdy czy cisz ekran dotykowy, mo e zosta wywo ana niezamierzona operacja w
sterowniku przez naci ni cie przyciskow.
Wy czenie urz dzenia HMI przed czyszczeniem zapobiegnie niezamierzonej odpowiedzi.
Uszkodzenia spowodowane przez nieodpowiednie rodki czyszcz ce
Urz dzenie HMI mo e zosta uszkodzone je li do czyszczenia u yjesz spr onego
powietrza, czyszczenia par , proszkéw szoruj cych lub mocnych rozpuszczalnikow.
Nie u ywaj tych produktéw do czyszczenia urz dzenia HMI.
Procedura

Post puj jak opisano:
1 Wy czurz dzenie HMI.
2. Spryskaj szmatk rodkiem do czyszczenia.
Nie spryskuj bezpo rednio urz dzenia HMI.
3. Wyczy urz dzenie HMI.
Gdy czy cisz wy wietlacz przecieraj od kraw dzi ekranu do rodka.
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7.2 Recykling

7.2 Recykling

Recykling i utylizacja

Urz dzenia HMI opisane w tej instrukcji u ytkowej mo e zosta poddana recyklingowi dzi ki
ma ej zawarto ci substancji szkodliwych. Skontaktuj si z odpowiedni firm odpowiedzialn
za utylizacj by podda recyklingowi swoje stare urz dzenia.
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81 Standardy i dopuszczenia

Aprobaty

A vwaca

Poni szy przegl d pokazuje mo liwe aprobaty.

Samo urz dzenie HMI jest certyfikowane tak jak pokazano na etykietach na tylnym panelu.

Znak CE

CC

System automatyzacji spe nia ogoélne, zale ne od bezpiecze stwa, wymagania nast puj cych
dyrektyw EC oraz spe nia Europejskie standardy zgodno ci dla PLC, publikowanych w
oficjalnych broszurach Unii Europejskiej:

e 2006/95/EG "Dyrektywa niskiego napi cia"

e 2004/108/EC "Kompatybilno elektromagnetyczna" (Dyrektywa EMC)

e Okre lone tempo absorbowania EN 50392

Deklaracja zgodno ci EC

Deklaracje zgodno ci EC s dost pne u odpowiednich w adz pod podanym adresem:

Siemens AG
Industry Sector
IIAASRD ST
PLC PO Box
1963

D-92209 Amberg

Oznaczenia dla Australii

O N117

Urz dzenie HMI spe nia wymogi standardu AS/NZS 2064 (Klasa A).
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8.2 Kompatybilno elektromagnetyczna

Aprobata UL

@

Underwriters Laboratories Inc., to
e UL 508 (Industrial Control Equipment)
e CSA C22.2 No. 142 (Process Control Equipment)

IEC 61131

Urz dzenie HMI spe nia wymagania i kryteria odpowiadaj ce IEC 61131-2, PLC, Cz 2:
Wymagania zasobOw operacyjnych oraz testy.

8.2 Kompatybilno elektromagnetyczna

Wprowadzenie

Urz dzenie HMI spe nia wymogi Dyrektywy EMC o rynku Europejskim oraz pozosta e
uwarunkowania.

Instalacja urz dzenia HMI zgodna z EMC

Instalacja urz dzenia HMI zgodna z EMC i u ycie odpornych na zak 6cenia przewodéw
s podstaw bezproblemowego u ytkowania. Podr czniki "Dyrektywy dla wolnej od
zak 6ce instalacji PLC" oraz "Sieci PROFIBUS" dotycz rownie instalacji urz dzenia
HMIL.
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8.2 Kompatybilnosc elektromagnetyczna

Zak 6cenia impulsowe

Poni sza tabela pokazuje zgodno elektromagnetyczn modu 6w w odniesieniu do zak éce
impulsowych. Warunkiem zgodno ci elektromagnetycznej jest spe nienie przez urz dzenie
HMI specyfikacji oraz wskazéwek dla tej instalacji elektryczne;.

Zak 6cenia impulsowe Testowane za pomoc Stopie
czuo ci

Wy adowanie elektrostatyczne Wy adowanie w powietrzu: 8 kV 3

w zgodno ci z IEC 61000-4-2 Wy adowanie przez kontakt: 6 kV

Przepi cia impulsowe (bardzo 2 kV przewdd zasilaj cy 3

szybkie chwilowe zak 6cenia) w 2 kV przewdd sygna owy, > 30 m

zgodno ci z IEC 61000-4-4 1 kV przewdd sygna owy, <30 m

Impulsy udarowe o wysokiej mocy w zgodno ci z IEC 61000-4-5, wymagane zewn trzny obwdd
zabezpieczaj cy (odniesienie w podr czniku Automation System S7-300, Installation, sekcja
"Lightning and overvoltage protection™)

Sprz enie asymetryczne 2 kV przewod mocy 3
Napi cie DC z elementami chroni cymi

2 kV przewod sygna u/danych, > 30 m,
z elementami ochronnymi jak potrzeba

Sprz enie symetryczne 1 kV przewdd mocy 3
Napi cie DC z elementami chroni cymi

1 kV przewdd sygna u/danych, > 30 m,
z elementami ochronnymi jak potrzeba

Zak 6cenia sinusoidalne

Poni sza tabela pokazuje zachowanie EMC modu 6w w odniesieniu do zak oce
sinusoidalnych. Wymaga to od urz dzenia HMI spe nienia specyfikacji instalacji
elektrycznej.

Zak 6cenia sinusoidalne Warto testu Stopie
czuo ci

Promieniowanie HF (w polach + 80% modulacja amplitudy na 1 kHz 3

elektromagnetycznych) w z 10 V/m w zakresie 80 MHz do 1 GHz

zgodno ci z IEC 61000-4-3 z 3 VIm w zakresie 1.4 GHz do 2 GHz

z 1 VIm w zakresie 2 GHz do 2.7 GHz

e 10 V/m z 50% modulacj impulsow na 900MHz
10 V/m z 50% modulacj impulsow na 1.89GHz

Zak 6cenie pr dowe RF na Napi cie testowe 10 V, z 80% modulacj 3
przewodach oraz ekranach amplitudow 1 kHz w zakresie od 9 MHz do 80MHz
odnosz ce si do IEC 61000-4-6
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8.3 Warunki przesy u i przechowywania

Emisja zak 6ce

radiowych

Poni sza tabela pokazuje niechcian emisj z pdl elektromagnetycznych w zgodno ci z EN
55011, Klasa warto ci limitu A, Grupa 1, mierzone w odleg o ci 10 m.

Od 30 do 230 MHz < 40 dB (uV/m) quasi-szczytowy

Od 230 do 1000 MHz < 47 dB (uV/m) quasi-szczytowy

rodki dodatkowe

By pod czy urz dzenie HMI do elektrycznej sieci publicznej, konieczne jest upewnienie
si , ejestonazgodnaz Klas warto cilimitu B do EN 55022.

8.3 Warunki przesy u i przechowywania

Mechaniczne i klimatyczne warunki przesy u i przechowywania

94

Warunki przesy u i przechowywania tego urz dzenia HMI spe niaj wymagania zgodne z IEC
61131-2. Poni sza specyfikacja dotyczy przesy u i przechowywania urz dzenia HMI w jego
oryginalnym opakowaniu.

Warunki klimatyczne spe niaj nast puj ce standardy:

e |EC 60721-3-3, Klasa 3K7 dla przechowywania

e |EC 60721-3-2, Klasa 2K4 dla transportu

Mechaniczne wymagania odnosz si do EC 60721-3-2, Klasa 2M2.

Typ warunku Dozwolony zakres

Test upuszczenia (paczka w transporcie) <1lm

Temperatura Od -20 do +60 °C

Ci nienie atmosferyczne Od 1080 hPa do 660 hPa, odpowiada wysoko ci
od -1000 do 3500 m

Wilgotno  wzgl dna Od 10 % do 90 %, bez kondensacji

Wibracje sinusoidalne w zgodno ci z 5do 8.4 Hz: 3.5 mm

IEC 60068-2-6 8.4 do 500 Hz: 9.8 m/s’

Wstrz s odpowiadaj cy IEC 60068-2-29 250 m/s®, 6 ms, 1000 wstrz S6wW

NOTA

Upewnij si , e nalub w urz dzeniu HMI nie ma wilgoci (pary wodnej) po transporcie w
niskich temperaturach lub po wystawieniu na ekstremalne wachania temperatur.

Urz dzenie HMI musi osi gn temperatur pokojow przed uruchomieniem. Nie wystawiaj
urz dzenia HMI na bezpo rednie promieniowanie z grzejnika w celu ogrzania. Je li pojawi a
si para, poczekaj oko o 4 godziny dopdki urz dzenie HMI nie wyschnie ca kowicie, przed

W czeniem.

Odpowiedni transport oraz przechowywanie, instalowanie oraz monta jak rownie

ostro naobsugas wymagane by zapewni bezproblemowe dzia anie oraz bezpieczne
u ytkowanie urz dzenia HMI.

Gwarancja urz dzenia HMI zostanie uniewa niona, je li te wymogi nie zostan spe nione.
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8.4 Warunki u ycia

Mechaniczne i klimatyczne warunki u ycia

Urz dzenie HMI jest zaprojektowane do u ycia w miejscach os oni tych przed efektami
pogody. Warunki u ycias zgodne z wymogami DIN IEC 60721-3-3:

« Klasa 3M3 (wymogi mechaniczne)

« Klasa 3K3 (wymogi klimatyczne)

U ycie z dodatkowymi rodkami

Urz dzenie HMI nie powinno by u ywane w nast puj cych lokacjach bez dodatkowych
rodkéw zabezpieczaj cych:

3. W miejscach nara onych na du e promieniowanie jonizuj ce

4. W miejscach ci kich warunkéw u ytkowych, spowodowanych na przyk ad przez:
- r ce opary, gazy, oleje lub chemikalia
- Elektryczne lub magnetyczne pola o wysokiej intensywno ci

« W zak adach, ktére potrzebuj specjalnego nadzoru — na przyk ad:
- Windy

- Systemy w specjalnych, niebezpiecznych pomieszczeniach

Mechaniczne warunki otoczenia

Mechaniczne warunki otoczenia dla urz dzenia HMI s okre lone w poni szej tabeli w
znaczeniu wibracji sinusoidalnych.

Zakres cz stotiwo ciwHz |Stae Okazyjne
10<f<58 Amplituda 0.0375 mm Amplituda 0.075 mm
58<f<150 Sta e przyspieszenie 0.5 g Sta e przyspieszenie 1 g

Redukowanie wibracji

Je liurz dzenie HMI jest poddane wi kszym wstrz som lub wibracjom, konieczne jest
podj cie dodatkowych rodkéw by zmniejszy przyspieszenie lub amplitud .

Radzimy umieszczenie urz dzenia HMI w materiale poch aniaj cym wibracje (na
przyk ad w metalowych poch aniaczach wstrz su).
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8.4 Warunki u ycia

Testowanie mechanicznych warunkéw otoczenia

Poni sza tabela dostarcza informacji o typie i zakresie testéw dla mechanicznych
warunkéw otoczenia.

Testowane dla Standard testu Komentarz
Wibracje Test wibracji w zgodno ci Typ wibracji:
z 1 EC 60068, cz 2-6 Zmiana cz stotliwo ci: 1 oktawa/minut .

(sinusoidalne) 10Hz<f<58Hz,

sta a amplituda 0.075 mm
58 Hz <f< 150 Hz,
sta e przyspieszenie 1 g

Trwanie wibracji:
10 cykli cz stotliwo cinao w kierunku
wszystkich trzech osi

Wstrz sy Test wstrz su w zgodno ci Typ wstrz su: Pé sinusoidalny

z 1 EC 60068, Cz 2-27 Intensywno  wstrz su:

Warto szczytowa 15 g, trwanie 11 ms
Uderzenie bezpo rednie:

3 wstrz sy w kierunku  wszystkich trzech osi

Zewn trzne warunki klimatyczne
Poni sza tabela pokazuje zewn trzne warunki klimatyczne dla u ycia urz dzenia HMI.

Warunki zewn trzne Dozwolony zakres Komentarz
Temperatura

¢« Monta pionowy Od0do50°C

¢ Monta podk tam Od 0do 40° C K t pochylenia max. 35°

Wilgotno  wzgl dna

10 do 90 %, bez kondensacji

Ci nienie atmosferyczne

1080 do 795 hPa

Odpowiada wysoko ci -1,000 do

2,000 m

St enie zanieczyszczenia SO2: < 0.5 ppm; Test: 10 cm*/m”; 10 dni
Wilgotno  wzgl dna < 60%,

bez kondensac;ji

H,S: < 0.1 ppm; Test: 1 cm*/m>; 10 dni
Wilgotno  wzgl dna < 60%,

bez kondensac;ji

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
96 Instrukcja u ytkowa, 01/2009, A5E02421799-01



Specyfikacja techniczna
8.5 Informacja o testach izolaciji, klasie ochrony oraz stopniu ochrony

8.5 Informacja o testach izolacji, klasie ochrony oraz stopniu
ochrony

Napi ciatestowe

Wytrzyma o  izolacji jest przedstawiana w te cie typu za pomoc nast puj cych
napi testowych w zgodno ciz IEC 61131-2:

Obwody napi cia nominalnego Ue do Napi cie testowe
innych obwodéw lub do uziemienia

<50V 500 VDC

Klasa ochrony

| klasa ochrony w zgodno ci z IEC 60536, np. potrzebne po czenie PE/terminal
uziemiaj cy do szyny profilowej.

Ochrona przed obiektami obcymi | wod

Stopie ochrony w zgodno ci z IEC Wyt umaczenie

60529

Przéd Gdy zamontowany:
« |IP65

e Za czony Type 4X/Type 12 (do u ytku wewn trz)

Panel tylni IP20

Test ochrony dotyku z u yciem standardowych sond.
Nie ma ochrony przed dost pem wody.

Stopie ochrony od przodu mo e by gwarantowany, je li uszczelka jest poprawnie
Zamocowana w wyci ciu monta owym. Przeczytaj odpowiednie informacje w sekcji
"Wykonanie wyci cia monta owego".

Zobacz réwnie

Wykonanie wyci cia monta owego (Strona 25)
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8.6 rod o zasilania

UWAGA

Bezpieczna izolacja elektryczna

U ywaj tylko zasilaczy 24 VDC z bezpieczn izolacj elektryczn ze zgodno ci z IEC
60364-4-41 lub HD 384.04.41 (VDE 0100, Cz  410), np. do standardu PELV.

rod o zasilania musi znajdowa si w okre lonym zakresie napi cia. W innym przypadku
nie wykluczone s awarie urz dzenia HMI.

Dotyczy nie izolowanych konfiguracji instalacji:

Pod cz GND 24V zwyj cia 24V rod a zasilania do po czenia ekwipotencjalnego by
ujednolici potencja . Powiniene zawsze wybiera centralny punkt po czenia.

Poni sza tabela pokazuje dozwolony zakres napi cia | odpowiedni zakres toleranciji.

Napi cie nominalne Zakres tolerancji
+24 VDC 19,2 do 28,8 V (-20%, +20%)
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8.7 Rysunki, wymiary

8.7 Rysunki, wymiary

8.7.1 Rysunki, wymiary KTP400 Basic
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8.7 Rysunki, wymiary

8.7.2 Rysunki, wymiary KTP600 DP Basic

All dimensions in mm.
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8.7.3 Rysunki, wymiary KTP600 PN Basic

All dimensions in mm.
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8.7 Rysunki, wymiary

8.7.4 Rysunki, wymiary KTP1000 DP Basic
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8.7 Rysunki, wymiary

8.7.5 Rysunki, wymiary KTP1000 PN Basic
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8.7 Rysunki, wymiary

8.7.6 Rysunki, wymiary TP1500 Basic
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8.8 Specyfikacje
8.8 Specyfikacje
8.8.1 Specyfikacje dla KTP400 Basic oraz KTP600 Basic
Waga
KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic Color
Mono PN Mono PN Color DP PN
Waga bez opakowania Okoo320g Okoo 1070 g

Wy wietlacz
KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic
Mono PN Mono PN Color DP Color PN
Typ LCD mono FSTN LCD TFT
Aktywny obszar 76,79 mm x 57,59 mm 115,2 mm x 86,4 mm
wy wietlania (3.8 6,7
Rozdzielczo w pikselach 320 x 240
Wy wietlane kolory 4 stopnie szaro Ci 256
Sterowanie kontrastem Tak Nie
Klasa b du pikseli zgodna - ]
z DIN EN ISO 13406-2
Pod wietlenie, redni czas LED CCFL
do po owicznej jasno ci 30.000 h 50.000 h

Urz dzenie wej ciowe

KTP400 Basic

KTP600 Basic

KTP600 Basic KTP600 Basic

Mono PN Mono PN Color DP Color PN
Typ Analogowy oporowy ekran dotykowy
Przyciski programowalne 6
Paski etykiet Tak
Pami
KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic
Mono PN Mono PN Color DP Color PN
Pami  aplikaciji 512KB
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8.8 Specyfikacje

Interfejsy
KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic
Mono PN Mono PN Color DP Color PN

1 x RS 422/RS 485 - - Max. 12 Mbps -

1 x Ethernet RJ45 10/100 Mbps RJ45 10/100 Mbps - RJ45 10/100 Mbps

réd o zasilania

KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic
Mono PN Mono PN Color DP Color PN

Napi cie nominalne +24V DC 19.2do 28.8V

Dozwolony zakres (-20%, +20%)

Maksymalna warto 35V (500 ms)

chwilowa

Minimalny czas pomi dzy 50s

dwoma warto ciami chwilowymi

Zapotrzebowanie na pr d

e Typowy okoo 70 mA oko 0 240 mA oko o 350 mA

+ Maksymalny stay pr d , oko 0 150 mA oko 0 350 mA oko 0 550 mA

* Moc udaru pr dowego I't 0ko 00,5 A’s 0ko 00,5 A%s 0ko 00,5 A%s

Wewn trzny bezpiecznik Elektroniczny

R6 ne
KTP400 Basic KTP600 Basic KTP600 Basic KTP600 Basic
Mono PN Mono PN Color DP Color PN

Zegar czasu rzeczywistego

Tak, niebuforowany
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8.8.2

Urz dzenie HMI

Specyfikacje KTP1000 Basic oraz TP1500 Basic

8.8 Specyfikacje

KTP1000 Basic Color DP KTP1000 Basic Color PN

TP1500 Basic Color PN

Waga bez opakowania

Oko 0 2,65 kg

Oko o 4,2 kg

Wy wietlacz
KTP1000 Basic Color DP |KTP1000 Basic Color PN |TP1500 Basic Color PN
Typ LCD TFT
Aktywny obszar wy wietlania 211,2 mmx 158,4 mm 304,1 mmx 228.1 mm
(10,4 (15")

Rozdzielczo w pikselach 640 x 480 1024x768
Wy wietlane kolory 256

Sterowanie jasno ci Tak

Klasa b du pikseli zgodna Il
z DIN EN I1SO 13406-2

Pod wietlenie, redniczas do CCFL

po owicznej jasno ci 50.000 h

Urz dzenie wej ciowe

KTP1000 Basic Color DP

KTP1000 Basic Color PN |TP15OO Basic Color PN

Typ Analogowy oporowy ekran dotykowy
Przyciski programowalne 8 przyciskéw programowwalnych Nie
Paski etykiet Tak Nie
Pami
KTP1000 Basic Color DP  KTP1000 Basic Color PN  TP1500 Basic Color PN
Pami aplikaciji 1024KB
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8.8 Specyfikacje

Interfejsy

KTP1000 Basic Color DP KTP1000 Basic Color PN  TP1500 Basic Color PN
1 x RS 422/RS 485 Max. 12 Mbps -
1 x Ethernet - RJ45 10/100 Mbps

Napi cie zasilanie

KTP1000 Basic Color DP |KTP1000 Basic Color PN |TP1500 Basic Color PN

Napi cie nominalne +24V DC 19,2 do 28,8V

Zakres, dozwolony (-20%, +20%)

Maksymalna warto  chwilowa 35V (500 ms)
Minimalny czas pomi dzy dwoma 50s

warto ciami chwilowymi

Zapotrzebowanie na pr d

¢ Typowy okoo 600 mA oko 0 800 mA
* Maksymalny stay pr d okoo 1000 mA oko 0 1000 mA
¢ Moc udaru pr dowego Pt oko o 02 A% 0ko 0 0.2 A%s
Wewn trzny bezpiecznik Elektroniczny

RO ne

KTP1000 Basic Color DP  KTP1000 Basic Color PN  TP1500 Basic Color PN

Zegar czasu rzeczywistego Tak, niebuforowany
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8.9 Zakres funkcjonalno ci z WinCC flexible

8.9 Zakres funkcjonalno ci z WinCC flexible

Poni sze tabele pokazu;j

obiekty, ktére mog by zintegrowane z projektem dla Basic Panel.

Alarmy
Obiekt Specyfikacja Basic Panels
Alarmy llo alarmoéw dyskretnych 200
llo alarméw analogowych 15
Dugo tekstu alarmu 80 znakow
llos zmiennych w alarmie Max. 8
Wy wietlanie Okno alarmy, podgl d alarmu
Potwierdzenie alarmu indywidualnie Tak

Roéwnoczesne potwierdzenie kilku alarmow
(potwierdzenie grupowe)

16 grup potwierdze

Edytowanie alarmu Tak
Wska nik alarmu Tak
Bufor alarmow Pojemno  bufora alarmu 256 alarmow
Rownoczesne kolejkowanie zdarze alarmu Max. 64
Przegl dalarmu Tak
Kasowanie bufora alarmu Tak

Zmienne, warto cii listy

Obiekt Specyfikacja KTP400 Basic, KTP1000 Basic,
KTP600 Basic TP1500 Basic

Zmienne llo 128 256

Nadzor limitu warto ci Wej cielwyj cie Tak

Skalowanie liniowe Wej cielwyj cie Tak

Listy tekstowe llo 150

Ekrany

Obiekt Specyfikacja Basic Panels

Ekrany llo 50
Pél na ekran 30
Zmiennych na ekran 30
Obiektéw z 0 onych na ekran (np. paskéw) 30
Szablon Tak
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8.9 Zakres funkcjonalno ci z WinCC flexible

Receptury

Wymienione warto cis warto ciami maksymalnymii nie powinny by dodatkowo u ywane.

Obiekt Specyfikacja Basic Panels

Receptury llo 5
Elementoéw na receptur 20
Rekordéw danych na receptur 20

Bezpiecze stwo

Obiekt Specyfikacja Basic Panels
Bezpiecze stwo llo grupu ytkownikéw 50

llo u ytkownikéw 50

llo autoryzacji 32
Info teksty
Obiekt Specyfikacja Basic Panels
Info tekst Dugo (ilo znakdw) 320

Dla alarmoéw Tak

Dla ekranow Tak

Dla obiektow ekranowych (na przyk ad pél I/O, Tak

prze cznikéw, przyciskdw, niewidzialnych przyciskow)

Funkcje dodatkowe

Obiekt

Specyfikacja

Basic Panels Mono Basic Panels Color

Ustawienia ekranu

Kalibracja ekranu dotykowego
Ustawianie jasno ci
Ustawianie kontrastu

Zmianaj zyka llo | zykéw 5
Obiekt graficzny Grafika wektorowa i pikselowa |Tak
Podgl d trendéw llo max. 25
Trend6w na widok llo max. 4
Obiekt tekstowy llo 500
KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Dodatek l \

Al Wskazowki ESD

Co oznacza ESD?
Wszystkie modu y elektroniczne s wyposa one w modu y i komponenty o wysokiej skali
integracji. Komponenty te s niezwykle czu e na przepi cia, czyli tak e na wy adowania
elektrostatyczne. Dlatego te te elementy s specjalnie traktowane jako ESD.

Skroty
Powszechnie u ywane s nast puj ce skroty w przypadku urz dze czuych na adunek
elektrostatyczny:
ESD - Electrostatic Sensitive Devices — urz dzenie czu e na adunek elektrostatyczny
ESD - Electrostatic Sensitive Device jako wspdélne oznaczenia mi dzynarodowe
Etykiety

Moduy ESD s etykietowane nast puj cym symbolem:

adunek elektrostatyczny

Ostrze enie
adunek elektrostatyczny

ESD mo e zosta zniszczony przez napi cie znacznie ni sze ni  proég odczuwania

cz owieka. Napi cia tego typu powstaj kiedy elementy s dotykane przez osob
nieuziemion przez elektryczno statyczn . Zazwyczaj jest to mao mo liwe, aby
uszkodzenie ESD w wyniku wy adowania zosta o natychmiast wykryte, zazwyczaj
dzieje si to dopiero po du szym okresie u ytkowania. Zabezpiecz si przed / roz aduj
swoj adunek elektrostatyczny zanim dotkniesz ESD!
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Dodatek
A.1 Wskazéwku ESD

Ka dy kto nie jest po czony z potencja em elektrycznym otoczenia jest nara ony

na adunek elektrostatyczny.

Poni szy rysunek pokazuje maksymalny adunek elektrostatyczny, na ktéry wystawiony jest
ka dy kto ma kontakt z wymienionym materia em. Warto ci te spe niaj specyfikacji

IEC 801-2.

> 0
Wzgl dna wilgotno powietrza
Rys. A-2 Napi cie elektrostatyczne, ktorym mo e by naadowana osoba.

Materia syntetyczny
We na
Materia antystatyczny taki jak drewno czy beton

rodki ochronne przeciw wy adowaniom elektrostatycznym

Ostrze enie

rodki Uziemiaj ce
Kiedy pracujesz z urz dzeniami czu ymi na wy adowania elektrostatyczne upewnij si ,

e osoba, miejsce pracy oraz paczka s dobrze uziemione. Pozwala to unikn  adunkow
elektrostatycznych.

Jako zasada, dotykaj ESD tylko je lijest to nieuniknione. Na przyk ad: konserwacja.
Kiedy dotykasz modu 6w, upewnij si e nie dotykasz pinbw na module lub cie ek PCB.
Zapobiega to wy adowaniom elektrostatycznym na czu e elementy, a przez

to uszkodzeniom.

Roz aduj adunek elektrostatyczny ze swego cia a je li wykonujesz pomiary na ESD.
By to zrobi dotknij uziemionego metalowego przedmiotu.

Zawsze u ywaj uziemionych urz dze pomiarowych.
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Dodatek A.2
Zdarzenia systemowe

A.2 Zdarzenia systemowe

Alarmy systemowe na urz dzeniu HMI dostarczaj informacji o wewn trznych stanach
urz dzenia HMI oraz PLC.

Nota

Alarmy systemowe s pokazywane tylko je li okno alarmoéw zosta o skonfigurowane.
Zdarzenia systemowe s wysy ane w j zyku ustawionym na twoim urz dzeniu HMI.

Parametry alarméw systemowych

Alarmy systemowe mog zawiera zakodowane parametry ktére s istotne przy rozwi zywaniu

probleméw poniewa dostarczaj odniesienia do kodu rod owego programu wykonawczego.
Te parametry s wysy ane po tek cie: ,Error code:”.

Alarmy systemowe w pomocy online

Lista wszystkich alarméw systemowych dla Twojego urz dzenia HMI jest dostarczona w
pomocy online dla WinCC flexible w sekcji Alarmy Systemowe ("System alarms").
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A.2 Zdarzenia systemowe
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Wykaz skrotéw

ANSI
CPU
Ccsv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR
EMC

American National Standards Institution — Ameryka ska instytucja standardéw
Central Processing Unit — Jednostka centralna

Comma Separated Values — Warto ci oddzielone przecinkiem

Clear To Send — Gotowy do przesy u

Direct Current — Pr d stay

Data Carrier Detect — Wykrycie no nej danych

Dynamic Host Configuration Protocol — Protokd komunikacyjny
Dual-in-Line — Obudowa dwurz dowa

Domain Name System — System nazw domenowych

Distributed /0O — Rozprowadzone wej cia/wyj cia

Data Source Name — Nazwa réd a danych

Data Set Ready — Gotowo  "modemu”

Data Terminal Ready — Gotowo terminala

Electromagnetic Compatibility — Kompatybilno elektromagnetyczna
European standard — Standard europejski

Engineering System — System in ynierski

Electrostatic Discharge — Wy adowanie elektrostatyczne

Electrostatic Sensitive Device — Urz dzenie wra liwe na adunek elektrostatyczny
Ground — Uziemienie, masa

High Frequency — Wysoka cz stotliwo

Human Machine Interface — Interfejs cz owiek - maszyna

International Electronic Commission — Mi dzynarodowa Komisja Elektrotechniczna
Interface - Interfejs

Input and Output — Wej cie i Wyj cie

Internet Protocol — Protokd Internetowy

Light Emitting Diode — Dioda wiec ca

Media Access Control — Sprz towy adres karty sieciowej

Metal Oxide Semiconductor — Pé przewodnik Metal Tlenek

Multipoint Interface (SIMATIC S7) — Protoké komunikacyjny wielopunktowy
Microsoft

Mean Time Between Failures — redni czas mi dzy awariami

Not connected — Nie pod czone

Operator Panel — Panel Operatora

Personal Computer — Komputer osobisty

KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic
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Wykaz skrétéw

PELV Protective Extra Low Voltage — Ochronne, bardzo niskie napi cie

PG Programming device - Programator

PLC Programmable Logic Controller — Programowalny sterownik logiczny

PPI Point-to-Point Interface (SIMATIC S7) — Protok6é komunikacyjny

RAM Random Access Memory — Pami  zapisywalna

RJ45 Registered Jack Type 45 — Typ z cza stosowany w telekomunikacji

RTS Request To Send —  danie wys ania

RxD Receive Data — Odbidr danych

SD Card Security Digital Card — Rodzaj karty pami ci

SELV Safety Extra Low Voltage — Bardzo bezpieczne niskie napi cie

SP Service Pack — Pakiet serwisowy

STN Super Twisted Nematic — Technologia stosowana w kolorowych wy wietlaczach

ciek okrystalicznych

Sub-D Subminiature D (plug) — Rodzina z cz szufladowych

TAB Tabulator

TCP/IP Transmission Control Protocol/Internet Protocol — Protoké internetowy

TFT Thin Film Transistor — Technologia stosowana w kolorowych wy wietlaczach
ciek okrystalicznych

TTY Teletype — Terminal

TxD Transmit Data — Transmisja danych

UL Underwriter’'s Laboratory — dzia aj ca w Stanach Zjednoczonych organizacja nie

nastawiona na zysk, stawiaj ca sobie za cel inspekcj

i certyfikacj produktéw pod wzgl dem spe niania
norm bezpiecze stwa

USB Universal Serial Bus — Uniwersalna magistrala szeregowa
UPS Uninterruptible power supply — Bezprzetwowe réd o zasilania
WINS Windows Internet Naming Service — Us uga wprowadzona przez firm Microsoft

umo liwiaj ca tumaczenie nazw komputeréw
na adresy sieciowe.
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Glosariusz

Alarm, aktywacja (Alarm, activated)

Chwila, w ktorej alarm jest wyzwalany przez PLC lub urz dzenie HMI.

Alarm, dezaktywacja (Alarm, deactivated)
Chwila, w ktérej aktywacja alarmu jest resetowana przez PLC.

Alarm, okre lany przez u ytkownika (Alarm, user-specific)

Alarmy okre lane przez u ytkownika zg aszaj okre lone stany zak adu pod czonego do
urz dzenia HMI poprzez PLC.

Alarmy systemowe (System alarms)

Alarmy systemowe s przypisane do klasy alarméw "System". Alarm systemowe zg asza
wewn trzne stany urz dzenia Hmi oraz PLC.

Czas u ytkowania do po owicznej jasno ci (Half Brightness Life Time)

Okres czasu, po ktérym jasno  wiecenia spada do 50% warto ci pocz tkowej.
Konkretna warto  czasu zale y od temperatury pracy.

Czas wy wietlania

Definiuje kiedy alarm systemowy zostaje wy wietlony na urz dzeniu HMI oraz jego czas
wy wietlania.

EMC

Electromagnetic compatibility — kompatybilno  elektromagnetyczna — jest to zdolno
sprz tu elektrycznego do prawid owego dzia aniaw rodowisku elektromagnetycznym
bez wywierania wp ywu na to rodowisko.

Ekran (Screen)

Tryb wizualizacji wszystkich logicznie po czonych proceséw danych w zak adzie.
Wizualizacjia procesow danych mo e by wspierana przez obiekty graficzne.

Infotekst (Info text)

Skonfigurowana informacja ustawiona o obiektach projektu. Na przyk ad infotekst alarmu
mo e zawiera informacje o przyczynie b du oraz wskazowki post powania.
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Instalacja (Plant)

Ogodlne poj cie odnosz ce si do maszyn, centrOw przetwarzania, systemow, instalacji
oraz proceséw ktére s sterowane i monitorowane na urz dzeniach HMI.

Kolejno zak adek (Tab order)
W trybie konfiguracji pozwala na ustawienie kolejno ci pokazywania obiektéw. Po
naci ni ciu klawisza <TAB> prze czana jest kolejna zak adka.

Komputer konfiguracyjny (Configuring PC)

Ogolne poj cie okre laj ce programatory (PG) oraz komputery (PC) na ktorych, stosuj ¢
specjalistyczne (in ynieryjne) oprogramowanie, tworzone s projekty instalaciji.

Kontrolka operatora (Operator control)

Kontrolka operatora jest komponentem projektu, ktory jest u ywany do wprowadzania
danych oraz wywo ywania funkcji. Przyk adowo kontrolk operatora jest przycisk.

Obiekt (Object)

Komponent projektu. Przyk ad: ekran lub alarm. Obiekty s u ywane by przegl da
i wprowadza teksty i warto ci do urz dzenia HMI.

Obiekt ekranowy (Screen object)

Odnosi si to do obiektow takich jak prostok ty, pola I/O lub kontrolki alarméw, ktére s
skonfigurowane do wizualizacji operacji w zak adzie.

Obraz urz dzenia HMI (HMI device image)

Plik, ktéry mo e by przes any z urz dzenia programuj cego na urz dzenie HMI. Obraz
urz dzenia HMI zawiera system operacyjny oraz elementy oprogramowania wykonawczego
(RT) potrzebne do startu projektu.

Oprogramowanie konfiguracyjne (Configuration software)

Oprogramowanie konfiguracyjne jest u ywane do tworzenia projektow do
wizualizacji proceséw. Dla przyk adu takim oprogramowaniem jest WinCC
flexible.

Oprogramowanie wykonawcze (Runtime software)

Oprogramowanie wykonawcze jest programem wizualizacji procesu, ktory mo e by
wykorzystany do testowania projektu na komputerze konfiguracyjnym.

Pami flash (Flash memory)

Pami nielotha zawieraj ca uk ad scalony EEPROM, u ywana jako przeno na pami
lub jako modu pami ci instalowany na p ycie g 6wnej.
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PLC

PLC to og6lne okre lenie urz dze isysteméw z ktérymi komunikuje si urz dzenie
HMI np. SIMATIC S7.

Plik projektu (Project file)
Plik, na podstawie ktérego s tworzone r6 ne pliki projektu, zale ne od konfiguraciji. Plik
réd owy nie jest nigdzie przesy any i zawsze pozostaje na komputerze konfiguracyjnym.

Rozszerzenie pliku rdéd owego ma posta *.hmi.

Plik projektu, skompresowany (Project file, compressed)

Skompresowany format pliku projektu. Mo e by on przesy any jako dodatek do pliku
projektu wykonawczego do odpowiedniego urz dzenia HMI. Funkcja "upload" musi zosta
aktywowana na komputerze konfiguracyjnym na czas przesy u. Skompresowany plik projektu
jest zazwyczaj zapisywany na zewn trznej karcie pami ci.

Skompresowany plik projektu ma rozszerzenie *.pdz.

Plik projektu, wykonawczy (Project file, executable)

Projekt wykonawczy jest generowany z pliku projektu dla okre lonego urz dzenia HMI. Plik
projektu wykonawczego jest przesy any do powi zanego urz dzenia HMI, w ktérym jest
u ywany do zarz dzania | nadzorowania zak adu.

Plik projektu wykonawczego ma rozszerzenie "*.fwx".

Pole (Field)

Zarezerwowany obszar w skonfigurowanych ekranach su ce do wprowadzania
i odczytu warto ci.

Pole I/O (I/O field)

Umo liwia wprowadzanie oraz odczytywanie warto ci na urz dzeniu HMI oraz przesy anie
ich do PLC.

Potwierdzenie (Acknowledge)

Potwierdzenie alarmu wiadczy, e zosta on zauwa ony.

Potwierdzenie, alarm (Alarm, acknowledgment)

Potwierdzenie alarmu wiadczy, e zosta on zauwa ony.

Praca PLC (PLC job)
Praca PLC wyzwala funkcj dla PLC na urz dzeniu HMI.
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Program aduj cy (Boot loader)
U ywany by uruchomi system operacyjny. Jest automatycznie rozpoczynany, gdy
urz dzenie HMI jest w czane. W trakcie rozruchu pojawia si  ekran startowy. Po
uruchomieniu systemu operacyjnego, otwiera si program aduj cy.

Projekt (Project)

Jest wynikiem konfiguracji wykorzystuj cej oprogramowanie in ynieryjne. Projekt
zazwyczaj zawiera kilka ekranéw z wbudowanymi obiektami systemowymi, podstawowymi
ustawieniami oraz alarmami. Plik projektu, ktéry zosta skonfigurowany w systemie WinCC
flexible jest zapisywany z rozszerzeniem *.hmi.

Mo na zauwa y r6 nice mi dzy projektem na komputerze konfiguracyjnym oraz tym

na urz dzeniu HMI. Projekt mo e by dost pny w wi kszejilo cij zykédw na komputerze
konfiguracyjnym ni na urz dzeniu HMI. Tylko projekt skonfigurowany na konkretne

urz dzenie HMI mo e by na nie za adowane. Na komputerze konfiguracyjnym mo emy
konfigurowa projekty dlaré nych urz dze HMI .

Przesy (Transfer)
Przesy projektu wykonawczego z komputera konfiguracyjnego do urz dzenia HMI.

Przycisk programowalny (Function key)

Przycisk na urz dzeniu HMI, ktéry wspomaga funkcje zdefiniowane przez u ytkownika
Funkcja jest przypisywana do tego przycisku podczas konfiguracji. Przypisanie przycisku mo e
by , lecz nie musi, typowe dla aktywnego ekranu.

Receptura (Recipe)
Kombinacja zmiennych, ktéra formuje struktur danych. Skonfigurowana struktura danych
mo e zosta przes ana na urz dzenie HMI. Mo na odwo a si do niej tak jak do rekordu
danych. Ich u ycie w recepturach zapewnia réwnoleg y przesy do PLC wszystkich
przypisanych do struktury danych.

STEP 7
STEP 7 to oprogramowanie dla SIMATIC S7, SIMATIC C7 oraz SIMATIC WinAC PLC.

STEP 7 Micro/WIN
STEP 7 Micro/WIN to oprogramowanie dla SIMATIC S7-200 PLC.

Symboliczne pole I/O (Symbolic I/O field)

Symboliczne pola /O s u ywane do wprowadzania i wy wietlania warto ci. Pole
zawiera list domy Inych wpiséw, z ktérych mo na wybriera odpowiedni.
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System automatyzacji (Automation system)
System automatyzacji to PLC serii SIMATIC S7 takie jak SIMATIC S7-300

Tryb przesy u ("Transfer" mode)

Tryb u ytkowy urz dzenia HMI do przesy ania projektow wykonawczych z komutera
konfiguracyjnego do urz dzenia HMI.

Urz dzenie HMI (HMI device)
Urz dzenie HMI jest to urz dzenie u ywane do sterowania i monitorowania maszyn oraz
instalacji. Stany maszyn oraz procesow w instalacjis wskazywane przez graficzne elementy
oraz diody na urz dzeniu HMI. Kontrolki operatora na urz dzeniu HMI pozwalaj
operatorowi na sterowanie procesami w instalacji oraz maszynami.

Wizualizacja procesu (Process visualization)

Wizualizacja proceséw produkciji, logistyki oraz us ug wykonywana jest w formacie
tekstowym oraz graficznym. Skonfigurowane ekrany instalacji pozwalaj operatorowi
na interwencje w pracuj cej instalacji poprzez odczyt i zapis danych.

Zdarzenie (Event)

Funkcje uruchamiane przez zdefiniowane, skonfigurowane przez u ytkownika zdarzenia.
Zdarzeniamog by przypisywane do przyciskéw, na przyk ad "Press" oraz "Release".

Zmienne (Tags)
Zdefiniowane miejsce w pami ci sk d mog by odczytywane i zapisywane dane. Mo e to
zosta wykonane zar6wno z poziomu urz dzenia HMI jak i PLC. W zale no ci czy zmienna
ma po czenie z PLC rozr6 niamy ,zewn trzne” (tzw. przetwarzania) oraz ,wewn trzne”,
w zale no ci czy zmienna jest pod czona do PLC.
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A F

Adapter k towy, 19 Faza konfiguracji, 65
Akcesoria, 19 Fazy kontroli procesu, 65
Aktualizacja Folia ochronna, 20

Za pomoc ProSave, 79, 83
Za pomoc WinCC flexible, 78, 82
Aktualizowanie
System operacyjny, 76, 80 |

Alarmy systemowe Informacje
W pomocy online, 113 Dodatkowe, 6
Parametry, 113 Instalowanie zgodnie z oczekiwaniami, 21
Aprobaty, 91 Instrukcje u ytkowe
Aprobata UL, 92 Cel, 3
Awaria zasilania, 71 Zakres, 3

Instrukcje bezpiecze stwa
Konflikt kompatybilno ci, 71
Kana danych, 77, 81

B Utrata danych, 76, 80

Bezpieczna izolacja elektryczna, 98 adunek elektrostatyczny, 111

Bezpiecze stwo Przewod po czenia ekwipotencjalnego, 32
Standardy, 91 Ogolne, 22

Promieniowanie wys. cz stotliwo ci, 21
rodki uziemiaj ce, 112
C Awaria zasilania, 71
Centrum szkoleniowe, 6 Przechowywanie, 94
Transport, 94
Niedozwolone rodki czyszcz ce, 89
Niezamierzona odpowied , 89

D Praca w szafce sterowania, 21
Deklaracja zgodno ci EC, 91 Interfejs RS-422/485
Dokumentacja Konfigurowanie, 40
Dodatkowa, 6 Interfejsy
Konwencije, 4 KTP1000, TP1500 Basic, 108
Dyrektywy EMC, 91 KTP400, KTP600 Basic, 106
Internet
Obs uga, 6
£ Izolacja elektryczna, 98
In ynierowie przygotowu;j cy, 3
Emisja, 22, 94 Y preys ey
ESD

Skroty, 111

Etykietowanie, 111
Etykietowanie

Aprobaty, 92

Deklaracja zgodno ci EC, 91
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K
Klasa ochrony, 97
Klawiatura ekranowa
Alfanumeryczna, 49, 51
Przypisanie przyciskow, 49, 51
KTP400 Basic, 48
KTP600, KTP1000, TP1500 Basic, 51
Numeryczna, 50, 52
Klimatyczne
Warunki przechowywania, 94
Warunki transportowe, 94
Komputer konfiguruj cy, 65
Konflikt kompatybilno ci, 71
Konfigurowanie
Ustawienia MPI/Profibus, 55
Ustwienia sieciowe, 56
Interfejs RS-422/485, 40
Konfiguraca zak adu
Nie izolowana, 98
Konwerter RS 422 na RS 232, 19
Konwerter
Przewod PC/PPI, 19
RS 422 na RS 232, 19
Przewod USB/PPI, 19
Kopia bezpiecze stwa, 67, 71,72, 74
Z u yciem ProSave, 74
Z u yciem WiInCC flexible, 72

L
Lokalizacja biura, 6

adunek elektrostatyczny, 111

M
Mechaniczne
Warunki otoczenia, 95
Warunki przechowywania, 94
Warunki transportu, 94
Miejsce dziesi tne, 50, 52
Monta
Kompatybilno EMC, 92
Urz dzenie HMI, 28

N

Napi cie nominalne, 98

Napi cie zasilania
KTP1000, TP1500 Basic, 108
KTP400, KTP600 Basic, 106

Nie izolowana konfiguracja instalacji, 98

(0]
Obs uga, 89
Ochrona has em
Aktywowanie, 63
Deaktywowanie, 63
Ochrona has em, 53, 54
Odci enie nacisku, 43
Odizolowywanie, 34
Offline
Tryb u ytkowy, 66
Test, 70
Online
Tryb u ytkowy, 66
Test, 70
Operatorzy, 3

P
Pami
KTP1000, TP1500 Basic, 107
KTP400, KTP600 Basic, 105
Panel sterowania
Otwieranie, 53
Ochrona has em, 53
PELV, 98
PLC
Konfigurowanie interfejsu, 40
Pod czanie
Komputer konfiguruj cy, 36
Wi zanie ekwipotencjalne, 32
PLC,39
réd o zasilania, 34
Programator, 35
Podstawowa wiedza
Wymagana, 3
Ponowne przygotowywanie, 65
Praca w szafce sterowania, 21
Promieniowanie wysokiej cz stotliwo ci, 21
PROFIBUS po czenia magistrali, 19
PROFINET wtyczka RJ45, 19
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Projekt
Testowanie ofline, 70
Testowanie online, 70
Przesy anie, 65
Promieniowanie
Wysoka cz stotliwo , 21
Przegl d, 54
Prze cznik DIP
Ustawianie, 40
Przekroj poprzeczny przewodu
Wi zanie ekwipotencjalne, 32
Przewod PC/PPI, 19
Przywracanie, 67, 71, 75, 73
Z u yciem ProSave, 75
Z u yciem WiInCC flexible, 73
Przesy, 65, 66, 67
Automatyczny, 68
R czny, 67
Przesy anie
Projekt, 65
Przewod USB/PPI, 19

R

Recykling, 90

Rozruch pocz tkowy, 65

Ré nica potencja 6w elektrycznych, 32

S
Serwis
W internecie, 6
Sprawdzanie
Warunki u ycia, 95
Zawarto pudeKka, 23
Standardy | aprobaty, 91

Warunki transportu i przechowywania, 94

Rama zaczepowa, 20
Sprawdzenie limitu warto ci, 50, 52
Specyfikacja techniczna

Wy wietlacz, 105, 107

Urz dzenia wej ciowe, 105, 107

Interfejsy, 106, 108

Pami , 105, 107

Napi cie zasilania, 106, 108
Stopie ochrony

Ochrona przed dost pem obiektéw obcych, 97

Ochrona przed wod , 97
System operacyjny

Aktualizacja u ywaj c ProSave, 79, 83
Aktualizacja u ywaj ¢ WinCC flexible, 78

Aktualizacja, 76, 80
Szafka sterowania
Pracaw, 21
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Technicy serwisowi, 3
Test izolacji, 97
Technicy obs ugi, 3
Tryb u ytkowy, 66
Zmienianie, 66
Offline, 66
Online, 66
Przesy, 66
Test
Zgodno elektromagnetyczna, 92
réd o zasilania, 98
Testowanie

U
Udost pnianie kana u danych, 54
Usuwanie, 90
Ustawienia fabryczne
Z ProSave, 86
Z WinCC flexible, 84
Urz dzenie HMI
Pod czanie, 30
Instalacja zgodna z EMC, 92
Monta , 28
Wy czanie, 43
W czanie, 42
Specyfikacja techniczna, 105, 107
Testowanie, 42
Urz dzenie wej ciowe
KTP1000, TP1500 Basic, 107
KTP400, KTP600 Basic, 105
Ustawienia MPI/Profibus, 54
Ustawienia Profinet, 54
Ustalenia zapobiegania wypadkom, 21
Ustalenia bezpiecze stwa, 21
Ustawienia ekranu
Edytowanie, 54
Ustawienia d wi ku, 54
Ustawienia przesy u, 54
Urz dzenie HMI, 42
Uwagi
Wy adowanie elektrostatyczne, 112
U ycie
Warunki, 95
Ze rodkami dodatkowymi, 95



w
Waga
KTP1000, TP1500 Basic, 107
KTP400, KTP600 Basic, 105
Warunki przechowywania, 94
Warunki przesy u, 94
Warunki otoczenia
Klimatyczne, 96
Mechaniczne, 95
Test, 96
Wibracje, 95
W czanie
Urz dzenie HMI, 42
Wsparcie techniczne, 6
Wygaszacz ekranu, 54
Wy czanie
Urz dzenie HMI, 43
Wi zanie ekwipotencjalne
Przewaod, 32
Pod czanie, 32
Wymagania, 32
Schemat pod cze , 33
W a ciwo cihas a, 54
W a ciwo ci OP
Urz dzenie, 54
Wy wietlacz, 54
Licencja, 54
Dotyk, 54
Wykaz skrétow, 115
Wy adowanie elektrostatyczne
Elektrostatyczne, 111
Uwagi, 112
Wy wietlacz
KTP1000, TP1500 Basic, 107
KTP400, KTP600 Basic, 105

z
Zak 6cenia
Impulsowe, 93
Sinusoidalne, 93
Zak Ocenia radiowe, 22
Zakres funkcjonalno ci
Bufor alarmu, 109
Alarmy, 109
Obiekty graficzne, 110
Tekst informacyjny, 110
Zmianaj zyka, 110
Monitorowanie warto ci limitu, 109
Receptury, 110
Bezpiecze stwo, 110
Ustawienia ekranu, 110
Ekrany, 109
Zmienne, 109
Listy tekstowe, 109
Obiekty tekstowe, 110
Kontrolka trendéw, 110
Zarejestrowany znak handlowy, 5
Zastosowanie
W obszarach zamieszka ych, 22
W przemy le, 22
Zawarto pude ka
Sprawdzanie, 23
Zegar
KTP1000, TP1500 Basic, 108
KTP400, KTP600 Basic, 106
Zdj cia produktu, 4
Znak CE, 91
Znak C-Tick (Australia), 91
Znak handlowy, 5
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